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Introduction
Online help describes the features and functionality of the Optimizely Digital Experience
platform and covers Optimizely CMS for content management, Optimizely Commerce for ecommerce functionality, Optimizely Campaign for omnichannel campaigns, Optimizely
Search & Navigation for extended search, Optimizely Visitor Intelligence for visitor profiles
and customer segments, Product and Email Product Recommendations, and Triggered
Messages for personalized product recommendations, and Optimizely add-ons.
You access the online help from within the Optimizely platform or from Optimizely World.
The online help is also available in PDF format for users who prefer PDF or want to print the
documentation.
This PDF describes the features and functionality of Optimizely CMS, which you can find
on Optimizely World. Developer guides and technical documentation also are found on
Optimizely World.
The user guide is intended for editors, administrators, marketers and merchandisers, working with tasks as described in Roles and tasks.
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Features, licenses and releases
The user documentation is continuously updated and covers the latest releases for the
Optimizely platform.
Optimizely CMS is the core part of the Optimizely platform providing
advanced content creation and publishing features for all types of website content. CMS features are available in all Optimizely installations.
Optimizely Commerce adds complete e-commerce capabilities to the
core functionality in CMS. It requires a specific installation and license.
Optimizely Campaign lets you orchestrate omnichannel campaigns from
a single screen, and send triggered emails based on real-time behavior.
Campaign requires additional license activation.
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Optimizely Search & Navigation adds advanced search functionality to
websites. It is included in the Optimizely Cloud services; for on-premises
installations it requires a specific installation and license.
Optimizely Visitor Intelligence is a user interface for viewing and filtering
visitor profiles, and creating customer segments that can be used in
omnichannel marketing campaigns. It requires a specific installation and
license.
Product Recommendations lets you create and configure a merchandising campaign with personalized product recommendations from
the personalization portal. It requires a specific installation and license.
Email Product Recommendations lets you include personalized product
recommendations in any email, including cart abandonment and retargeting emails, from the personalization portal. You can also work with
behavioral triggers to detect on-site behaviors and act upon them
through automated, personalized emails. It requires a specific installation and license.
Add-ons extend the Optimizely capabilities with features like advanced
search, multi-variate testing, and social media integration. Some add-ons
are free, others require license activation. Add-ons by Optimizely are
described in the online help.
Note: Due to frequent feature releases, this user guide may describe
functionality that is not yet available on your website. See What's new
to find out in which area and release a specific feature became available.

Images and screenshots
The Optimizely user guide uses images and screenshots to visually guide you through the
features of the Optimizely platform. Due to different versions, continuous updates, and specific system permissions, images and screenshots may differ from the actual appearance.
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Notes
Three types of notes are color marked throughout the user guide: tips, notes and warnings.
Tip: Green indicates tips that might show you an easier way to perform a task.

Note: Yellow indicates important information that may affect your
work and should not be missed.

Warning: Red indicates warnings. If these warnings are ignored, serious errors or problems may occur.

Copyright notice
© Optimizely 1996–2022. All rights reserved.
All information and content within this document is the sole copyright of Optimizely which
includes all companies and affiliates in the Episerver group. Changes to the contents, or
partial copying of the contents, may not be done without permission. The document may
be freely distributed in its entirety, digitally or in printed format, to all users of Optimizely
and Episerver Software. Optimizely assumes no liability or responsibility for any errors or
omissions in the content of this document. Optimizely reserves the right to alter functionality and technical system requirements. ‘Optimizely’ is a registered trademark of
Optimizely Inc. Ektron is a registered trademark of Episerver Inc.

© Optimizely 2022

Introduction | 13

Optimizely CMS
Optimizely CMS provides powerful web content management capabilities, available
through an intuitive user interface, allowing both experienced and occasional users to
work efficiently with content.

Content management features
Optimizely CMS provides powerful web content management capabilities, available
through an intuitive user interface, allowing both experienced and occasional users to
work efficiently with content.
l

Creating pages and content blocks

l

Adding images
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l

Linking content

l

Content collaboration

l

Managing content versions

l

Content approvals

l

Working with multi-language content

l

Managing permissions in the Optimizely CMS Admin user guide
Note: The Optimizely Digital Experience Platform contains many features to support you in your daily work. Depending on how your solution is set up, some features described in this documentation may
not be available to you. Contact your system administrator to find
out more. See Optimizely World for technical information.

Roles and tasks
Optimizely is designed to interact with website visitors, and for collaboration among users
of the platform. This topic describes typical roles and related tasks used in scenarios. See
Setting access rights in the CMS Administrator User Guide to configure user groups and
roles in Optimizely.

Visitor and customer
A visitor is someone who visits a website to find information or to use services. If the website is an e-commerce site, the visitor can be a customer with purchasing intentions. A customer can purchase on an e-commerce website "anonymously" (payment and shipping
details provided), or by registering an account. Visitors may also contribute to website content as community members, which usually requires registration of an account profile.

Community member and moderator
A community member or a visitor can add content, if social features and community functionality are available for the website. This content includes forum and blog postings,
reviews, ratings and comments, in which case an editor, or a specific moderator role for
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large websites and online communities may need to monitor this type of content on the
website.

Recipient
A recipient is an individual who has opted-in to receive emails from a business, for example
when purchasing from the website. Recipients and their associated data are managed in
recipient lists that are used for omnichannel marketing. You can track and analyze recipient actions, such as clicking links in an email, providing input to website owners and users
for further marketing actions.

User
A user is someone who logs in to the Optimizely user interface to work with different parts
of the platform. A user can belong to one or more user groups and have different roles,
depending on which parts of the Optimizely platform they use, their tasks, and the size and
setup of the organization.

Website owner
A website owner is someone with overall business and/or technical responsibility for the
content and performance of one or more websites. The website owner may monitor reports
for activities such as page conversions1, customer reviews, or sales progress; rarely creates content but can be involved in the approval of content created by others. A website
owner may also have administrative access, and be the owner of mailing clients used for
organizing campaign mailings.

Content editor
A content editor is someone with access to the editorial interface who creates and publishes content on the website. Content editors with understanding of the website content
work with search optimization for selected content in search results. Editors may also want

1When a website visitor takes a desired action. This desired action can be, for example, buying

an item, filling in a form, or clicking a link.

© Optimizely 2022

16 | Optimizely CMS Editor User Guide 2022-03-14

to follow-up on content with unusually high or low conversion rates1 to update or delete
this content.

Marketer
A marketer creates omnichannel2 campaigns3 and content with targeted banner advertisements to ensure that customers get a consistent on-site experience. The marketer also
monitors campaign KPI4s (key performance indicators) to optimize page conversion. A marketer with understanding of the website content may also optimize search for campaigns,
and promote content using personalization5 features.

Merchandiser
A merchandiser typically works with stock on an e-commerce website to ensure that the
strongest products are put in focus. This role may create landing pages6, enrich product
content, set product pricing, coordinate cross-product selling, oversee delivery and distribution of stock, and deal with suppliers. A merchandiser may want to identify search
queries with unusually high or low conversion rates, to adjust the search. May also work
with product promotion using personalization features.

Customer Service Representative
A customer service representative (CSR) works in the Optimizely Commerce order management user interface. Tasks may include updating or creating orders, updating customer

1Number of conversions divided by the number of views of an item.
2Multiple channel marketing (on website, mobile, retail store, and so on) that provides an integ-

rated experience for buyers.
3Commerce: a set of related components and activities used for promotions. A campaign
organizes marketing activity and is associated with discounts (promotions), customer segments, and markets.
4Stands for "key performance indicator" (also known as a conversion goal); the measurement
of actions on web pages. The actions can be completed purchases, pages visited, time spent
on site and so on.
5Adapt content to customized target groups for a more personalized website experience, such
as displaying different content to first time and returning visitors. (See visitor groups.)
6A landing page is the target page on which a visitor "lands" after clicking a banner or link. Usually, a landing page is a web page that is separate from the main page, with the goal that the
visitor performs a certain action (conversion).
© Optimizely 2022
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information, and managing subscriptions and payments. The manual order work is often initiated by customers through a support function.

Administrator
An administrator configures system settings from the administration user interface, including search, languages, personalization, and user access. Administrators usually have extended access rights compared to other user groups, and can access all parts of the
Optimizely platform. They may also have administration access to integrated third-party
systems. The administrator may also be the contact person for communication with the
developers maintaining the website.

Developer
A developer is someone with source code access and programming skills. Developers work
with website configuration, implementation, maintenance and development of new functionality. They create the rendering templates for content and product catalogs, configure
e-commerce settings, and manage indexing and customized search features. Developers
may also install integrations and third-party extensions. Developers may be associated directly with the organization owning the website, or with an external partner company.
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What's new?
This user guide describes functionality available in the latest release of a standard implementation of the Optimizely platform software and services. New features are continuously
made available. See Optimizely updates.
Note: Due to frequent feature releases, this user guide may describe
functionality that is not yet available to you. Contact your system
administrator for information about products and versions in your
Optimizely implementation.
This release of the Optimizely User Guide describes features available in Optimizely as of
2022-03-14. See release notes (below) for update history. See Archived documentation in
the online version of the user guide for previously released user guides and for older
release notes.

Release notes 2022
Released

Area

Features and updates

2021-10-21

Campaign

You can now create webhooks for the spam
complaint event.

2021-10-15

Campaign

The new topic, Setting up the List-Help
header, has been added.

2021-09-30

Campaign

As part of the rebranding, the images and
attachments feature was redesigned. It is now
complete and includes the option to delete created images and attachments. (update 379)
When creating or editing users, you can now
specify allowed IP addresses and IP ranges
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Released

Area

Features and updates
to restrict access to the user account. See
Managing users. (update 379)

2021-09-28

CMS

The Reports view is no longer supported and is
removed. (update 378)

2021-09-28

CMS

The admin view is redesigned. (update 378)
Visitor groups user interface is redesigned.
Criteria previously included in the add-on
Visitor Group Criteria Pack are now
included in Optimizely CMS by default, see
Built-in visitor group criteria. (update 378)

2021-09-28

CMS

2021-09-28

CMS

The dashboard is no longer supported and is
removed. Gadgets are now only installed in the
navigation or assets panes. (update 378)

2021-09-28

Commerce

The Commerce Manager administration system is removed, and replaced with a new
Administration view, from where you can
define markets and warehouses, index catalogs, configure taxes, shipping, and payments,
and work with dictionary properties. (update
378)

2021-09-28

Commerce

A new Customers view replaces the legacy
Customer Management in Commerce Manager. (update 378)
Some functionality, previously managed from
Commerce Manager, is now managed through
code:

2021-09-28

Commerce

l

l

Dictionaries. Adding currencies, countries,
and return reasons.
Dictionaries. Adding values for organizations and contacts.
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Released

Area

Features and updates
l

l

Catalog batch updates and catalog
import/export.
Management of business objects, and
catalog and meta-classes fields.

See Optimizely World for technical details,
and previous versions of the user guide for
the removed legacy functionality. (update
378)

2021-09-23

Mailings Classic and Reports will be deactivated on 2022-03-01. To migrate your mailings to Smart Campaigns, see Mailings Classic.
To migrate your reports to the Performance
Dashboard and Deep Analytics, see Reports.
(update 377)

Campaign

The current Apple operating system versions
include the Apple Mail Privacy Protection,
which restricts the transmission of tracking
information to Optimizely Campaign. See
Apple Mail Privacy Protection.

Campaign

You can now merge mailing content from different campaigns into a new campaign. See
Merge content. (update 377)

2021-09-02

Campaign

When importing recipients, you can now merge
the contents of recipient list fields of type
"String" and "Text". You can either append or
prepend the content or replace the old content with the new one. (update 376)

2021-08-12

Marketing automation connectors

The configuration settings screen of the
Microsoft Dynamics CRM connector was
updated.

2021-08-02

Campaign

The redesigned user interface has been
released. Optimizely Campaign screenshots in
the user guide have been updated. See Start

2021-09-09
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Released

Area

Features and updates
page.

2021-07-22

Marketing automation connectors

The Pardot connector has a breaking change
when you upgrade to version 6. The configuration screen has new fields to create new
connectors. Configurations made with older
versions of the Pardot connector will no longer
work.

2021-07-20

Campaign

You can now create webhooks for the unsubscribe event. (update 373)

2021-07-13

Email Product Recommendations

New strategy: Recommendations from categories of purchased products (last 365 days)

2021-06-24

Campaign

If you use the coupon system, you can now
optionally create QR codes. You can also use
field functions to generate QR codes that refer
to specific recipient list fields. (update 371)

2021-06-17

Campaign

See Deliverability basics for information about
the BIMI email authentication standard.

2021-06-14

B2B Commerce

Spire roles documented.

2021-06-09

B2B Commerce

Adyen payment gateway plug-in documented.

2021-05-27

Marketing automation connectors

Fields were added to the Acoustic (Silverpop)
Connector setting screen to include database
lists. (update 368)

2021-05-13

Campaign

In Deep Analytics, you can use separate groupings for the name and ID of mailings, recipient
lists, and clients. See Groupings. (update 366)

2021-04-29

Triggered Messages

A new feature was added to the Targeted Discount daily trigger to enable the trigger to fire
if products were added to a basket but not pur-
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Released

Area

Features and updates
chased within the last 30 days.
You can now create webhooks for the bounce
event. (update 364)

2021-04-22

Campaign

2021-04-15

Campaign

See Deliverability basics for information
about list bombing and learn how to recognize these cyberattacks and protect yourself.
See Deliverability basics for a glossary of the
most important terms related to deliverability.
The beta phase of the webhook feature has
been expired. You can now create webhooks
for the sent event and optionally submit the
Basic HTTP Authentication header. You can
also verify and update webhooks via REST API.
See Webhooks. (update 362)

2021-03-31

Campaign

You can now display background images in
grouping paragraphs and sidebars in the
mobile newsletter version. You can also automatically stretch or crop the image to fill the
entire paragraph area. See Grouping paragraph. (update 362)
The beta phase of the A/B tests for transactional mails feature has been expired. This
feature is now available for all users on
request.

2021-03-25

Visitor Intelligence

2021-03-25

Campaign

Visitor Intelligence now comes with a set of
built-in filter definitions. It is also possible to
add time and occurrence filters to segments to
further limit matching profiles. See Creating a
segment based on filter definition. (update 360)

In the Optimizely Campaign start menu under
Scheduled jobs, you can find an overview of
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Released

Area

Features and updates
the scheduled jobs configured in your client.
(update 360)
If you use the coupon system, you can generate bar codes based on the values of your
recipient list fields via field functions.

2021-02-18

2021-02-04

2021-01-21

2021-01-21

Campaign

In the Marketing Automation's Advanced node,
you can specify which recipients are passing
through the Marketing Automation campaign
at which time. You can now define even more
precisely when Optimizely Campaign should
check the criteria. For example, if you set the
interval to Every 2 months, each 1st from 14:00,
Optimizely Campaign checks the criteria on
the first day of every second month at 14:00.
(update 355)

Campaign

If you use the recipient list management, you
can now change the field name of recipient list
fields. See Editing recipient list fields. (update
352)

B2B Commerce

The end user documentation for
B2B Commerce and Optimizely PIM has now
been integrated in this user guide. See sections Optimizely B2B Commerce and Optimizely PIM.

CMS

Edit and publish blocks in a quick edit view,
which lets you edit relevant block properties
without leaving the current context. (update
350)
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Released

2021-01-21

Area

Features and updates

Customer service representatives can create
notes associated with carts, orders, and subscriptions (update 349).

Commerce

l
l

2021-01-21

Personalization
l

2021-01-21

Create reusable email templates
Export CSV data in localized format for the
selected language
Users (with authorization) can change the
currency selection

You can now run A/B tests for transactional
mails to send different variants of a transactional mail and check which variant performs
better.

Campaign

Archived documentation
If your Optimizely implementation is not on the latest version, you can access previous versions of the Optimizely User Guide under Archived documentation in the online version of
the user guide.
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Getting started
This topic describes how to log in to an Optimizely website, access features and navigate
the different views. The login procedure may be different from what is described here,
depending on how your website and infrastructure are set up.

Logging in
As an editor or administrator, you usually log in to your website using a specified URL, a
login button or link. Enter your user name and password in the Optimizely login dialog box,
and click Log In.

Accessing features
What you are allowed to do after logging in depends on your implementation and your
access rights, since these control the options you see. When logged in, the Optimizely
quick access menu appears in the upper right corner.
Selecting CMS Edit takes you to the edit view and other parts of the system.

Navigation
Navigation within CMS and to other parts of the Optimizely platform is done via the top
menu.
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Next steps
l

l

l

l

l

l

l

The User interface and Roles and tasks topics describe the different parts of the user interface and the Optimizely user roles.
Creating content in the CMS Editor User Guide describes how to create content with
images, blocks, links, and forms.
Managing content in the CMS Editor User Guide describes how you can translate, preview, and compare content. It also describes how you can structure the website by moving, copying, and sorting pages and so on in the page tree.
For publishing and collaboration, see Working with versions and Controlling the publishing
process in the CMS Editor User Guide.
Administration interface in the CMS Administrator User Guide to administer and configure
settings in Optimizely.
If you have Optimizely Commerce installed, see the Commerce User Guide to work with ecommerce tasks.
If you have Optimizely Search & Navigation installed, see the Optimizely Search
& Navigation User Guide to work with search optimization.
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User interface
The toolbar and the panes in the Optimizely edit view provide easy access to functions
when working with content. When entering the edit view, you have the top menu and the
toolbar at the top, and adjustable panes to the left and right.

Note: The Optimizely user interface is flexible allowing developers to
plug-in customized features when implementing websites. This
description refers to Optimizely CMS without further customizations.

The toolbar contains features like preview and view options, and lets you add items such
as pages or blocks.
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The page information area below the toolbar displays the page name, the path to the page
and when it was last autosaved. If it is possible to undo the latest changes you did to the
content, there is also an Undo link.

A notification toolbar may be displayed below the toolbar showing information, confirmation, error messages and so on.

General features
l

l

l

Context-sensitive actions. Some features are only available in certain context. The toolbar (for example) presents relevant actions depending on what you are currently doing,
and the add (+) button also offers context-sensitive options.
Primary actions. Some actions open in a new window, for example, a page delete confirmation. The background is then dimmed, meaning that you must finish the primary
action to continue.
Action feedback and notifications. Successful actions are confirmed by a message in
the notification bar. A notification may also appear in case of an error requiring you to take
action.
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l

l
l

l

l

l

l

Drag-and-drop operations. Drag and drop is supported in many areas. For example, you
can drag pages, media files and blocks into the rich-text area or content areas, or
rearrange the page tree structure using drag-and-drop.
Tooltips. Hover over a button or field and a short tooltip appears.
Keyboard commands. Standard keyboard commands are supported in many areas, such
as when you move pages in the page tree or in the rich-text editor.
Search. Supported in many areas to locate, such as pages in the page tree or media in the
folder structure.
Adaptable work environment. Resize and pin the panes depending on what you are currently doing, and add and remove gadgets of your choice for quick access to functionality.
Support for time zones. Publishing actions in the edit view are done in your local time
zone, whereas administrative actions are based on server time.
Context menus are available in many areas, such as in the panes, the page tree and in
item listings. The menu displays different available options depending on where in the
interface you are and what you are doing.
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Panes
The user interface has a left-hand and a right-hand pane, which can be adjusted and
extended with additional gadgets.
Pane pin is used for expanding and locking the panes in an open position.
Settings for a pane or a gadget allow you to configure or remove a gadget, or
rearrange gadgets in a pane.

Left-hand navigation pane
Contains the page tree structure (Pages), language branch (Sites) navigation, tasks management (Tasks), and project items (Project Items) by default.
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Right-hand assets pane
Contains the Media and Blocks folder structures by default. Drag and drop one or multiple
items from the assets pane into the content you are currently working on.
You can also drag and drop multiple items within the assets pane, and delete, cut or copy
and paste them, from the context menu or with standard keyboard shortcuts. Any unselected children folders are also moved, copied or deleted.
Note: If you copy and paste multiple folders on different levels, they
will be on the same level when pasted.

If you have Optimizely Commerce or Optimizely Forms installed, the assets pane also displays the Catalogs and Forms gadgets per default.
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Editing
The toolbar on top displays an actions menu with context-sensitive publishing options
which vary depending on content status and user access rights. During editing, content
status and autosave information are displayed.

When working with content such as pages and blocks in CMS, or catalog content in Optimizely Commerce, there are two editing views, On-Page Editing and All Properties, with
buttons to switch between them.
On-Page Editing view provides quick access to direct editing of a selection of content
properties.
All Properties view provides access to all available properties including more
advanced ones such as access rights and language settings.
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When editing content properties, these options are common when adding, deleting, or
selecting items:
Click to select (a category, for example).
Click to select (an image in a media folder, or a page in the page tree).
Click to remove (a category, for example).

Real-time Updates
Optimizely is by default set up to display project comments and changes to projects in the
user interface immediately. If Optimizely experiences problems with the these immediate
updates, the following dialog box appears.

The Real-time Updates dialog box can have two main reasons. It appears because Optimizely has encountered a network problem and cannot connect to the web server, or
because your system does not have the WebSocket protocol enabled, which is used for
the real-time updates of the user interface.

Network problems
Network problems occur if there is an error in the web server configuration, or if there are
problems with your corporate network or the with Internet connection. As long as there is a
problem, you are unable to continue working with Optimizely.
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Whatever the reason, Optimizely will try to reconnect to the web server. If it still cannot
connect after a number of attempts, you get an error message saying: "The server has
been unavailable for an extended period of time. Please verify the internet connection and
refresh the browser."
Contact your IT department or Internet service provider if the problem persists.

WebSocket support
WebSocket is an Internet protocol used to automatically update the Optimizely user interface.
If you are using the projects feature, the WebSocket protocol is used to check for new or
updated comments and project items from other users. As soon as one of your colleagues
adds a comment or project item, Optimizely automatically updates your user interface and
displays the comment or item (assuming you have the projects interface open).
However, the WebSocket protocol must be enabled for your system by an administrator for
the real-time updates to work. If it was not enabled, you can still work with Optimizely and
with projects and comments but you need to manually refresh the user interface with the
Refresh button to see new comments or items.
Depending on the system configuration when the WebSocket protocol is disabled, you
may or may not see the Real-time Updates dialog box.

My settings
Under the top menu > your user name > My settings, you can change some of your
account settings. User name and password are usually set in an external system, such as
Windows or an SQL database, and cannot be changed in Optimizely in that case.
In the Display Options tab, you find the following settings:
l

Personal language. Select your desired user interface language from the drop-down list.
This settings affects the language of the user interface, such as texts in buttons and dialog
boxes. It does not affect the language of your website.
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l

l

Limit touch support. On touch-screen devices, browsers may have difficulties prioritizing
between input from the screen and from the computer mouse, which may cause problems
such as making it impossible to resize panes using the computer mouse. If you experience
problems with Optimizely and the touch screen, enable the Limit touch support feature.
This feature prioritizes computer mouse input over touch screen input and enables the
computer mouse for interactions such as drag and drop, resizing of panes, and so on.

Reset all views to system default. You can reset your user interface views to the settings. If you have changes to the user interfaces, such as added, moved or deleted gadgets, these changes are undone and the default views are displayed.

Add-ons
An add-on is a plug-in or module, developed by Optimizely or Optimizely partners, to
extend the capabilities of Optimizely. A developer (or someone with administrative access
rights) installs most add-ons. See Optimizely World for installation, configuration, and customizing details for each add-on.
When they are installed on the website, you can add some of the add-ons as gadgets to
the dashboard or to the navigation or assets panes in edit view.
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Working in On-page editing view
On-page editing is what you see when accessing the edit view in Optimizely. From here
you can instantly start editing content; the areas that are available for editing are highlighted. The available areas depend on how the page type was defined and each area is
set up with a property type which controls what you can do with each area. One area can,
for example, have an image property type and is intended for images; another area can
have a page description property and is intended for text describing the page. This means
that you will have different editing options when clicking an area, depending on the area's
type of property. Typically for a page, you can edit page name, description, the main editorial area, and perhaps a content area with blocks.
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Note: Areas and properties available for editing are implementationspecific, and depend on the type of property and how the rendering
is built on your website.

Example: Editing a page through on-page edit
This example describes how to edit a page, but the procedure is similar when editing
blocks or catalog content if you have Optimizely Commerce installed.
1. Select the page to edit from the page tree in the navigation pane.
2. Click an area to edit (property names will be displayed on mouse-over).
3. Make your changes by updating the content properties as needed. See also: Using the
rich-text editor.
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4. Your changes are automatically saved, and a draft version of the content (page, block
and so on) is created.
5. At any time, you can access the preview option at the top to see what the published
version will look like.
6. When done, publish the content or apply any of the other options described in Publishing and managing versions.

Editing additional properties
The on-page editing view contains a number of properties which are reached by scrolling
to the very top of the page with the wheel on your computer mouse. These are called basic
info properties and can be used to add a simple address, set access rights for a page or to
change the name in the URL and so on.
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Not all properties are available in the on-page editing view; to see all properties, switch to
the All properties editing view.

Working in All properties editing view
The All properties editing view provides editing access to all properties available for content, including those that are not available in the On-page editing view. Select All Properties in the toolbar to access these additional properties.
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Note: Areas and properties available for editing are implementationspecific, and depend on the type of content on your website. This
topic describes some tabs and properties as they appear in the
Optimizely sample templates.

Global properties
If you have content in multiple languages on your website, some properties may be locked
for editing in a specific language. These properties are globally shared and you can edit
them only in the master language1. See Translating content.

Basic info properties
The top gray area displays the basic informational properties which are also accessible in
the on-page editing view. This area appears in the All Properties editing view.
Property

Name

Name in URL

Description
The name of the page. Depending on the implementation, this may be the
heading of the page, and it is also shown in the page tree structure and
menus.
The page URL2 is automatically created based on the name of the page
and its place in the navigation. It depends on the implementation if this is
visible in links on the website. If you copy a page, the URL of the original
page is copied with a number added to it. Change this if you create new
content based on existing page copies.
Warning: Changing the URL for an existing page
may cause broken links.

1The language in which the first version of content is created.
2Stands for "Uniform Resource Locator". Also known as a web address such as http://-

world.optimizely.com.
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Property

Description

Simple address

This is a unique URL that can be added to frequently requested pages on
your website, letting visitors locate the page simply by typing the simple
address name directly after the main URL of the website. Providing, for
example, products as a simple address lets you find the page just by entering the URL (for example, https://www.company.com/products) in the
address bar of the browser even if the Products page is located further
down in the navigation tree. You can use the Simple address report to manage simple addresses for your website.

Display in navigation

Deselect this option for pages that you do not want to be visible in navigation structures or menus on the website.

Visible to

Indicates if public access to the content is restricted. Click Manage to
change these settings as described in Setting access rights from edit view.

Languages

Shows available languages for the content. If you have multiple languages
on your website, see Working with multiple languages.

ID, Type

Shows the unique ID set by the system and the type of content on which
the content is based.
Under tools, you find the following options:
l

Tools

l

l

Language Settings. Used to set fallback and replacement languages,
see Fallback languages.
Manage Expiration and Archiving. Used to set published content as
expired and for archiving content, see Setting expiration of content.
Permanently Mark as Being Edited. Used to notify editors that
someone is working on the content item. See Working with shared
content.

Tabs
All other properties are organized using tabs. These can be added and modified in code
and from the administrative interface.
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Content tab
The Content tab contains properties for entering the main content, when editing a page
or a block in CMS, or catalog content if you have Optimizely Commerce installed.

Property

Description
Categorization of content is useful in filtering functionality for search, navigation and listings. You create a category in the administrative interface
before you can apply it to content in edit view.

Category

Note: A category is a built-in property in Optimizely CMS. You can apply a category to content,
but your website also needs customized functionality to display the resulting outcome, such as
in a filtering. Also, do not confuse content categories with Optimizely Commerce categories; see

© Optimizely 2022

User interface | 43

Property

Description

Creating a catalog entry.

Main body

Example of a rich-text editor property, for adding editorial content such as
text, images and links. See Using the rich-text editor.

Settings tab
The Settings tab is default and contains a set of built-in properties for managing publication dates, sort order and shortcuts.
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Property

Description

Published, Created
and Modified

System-generated timestamps for the content that rarely need to be
changed.

Update modified
date

Select this check box if you have made significant changes to the content
and want the system to update the modification date and include the content once more, such as in a subscription send-out.
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Property
Sort subpages and
sort index

Description
Defines the sort order for pages in the page tree structure and navigation
menus. See Structuring the website.
Creates menu or navigation links. A shortcut will not display any content of
its own, instead it becomes a menu option linking directly to some other content on the same website or on an external website. Click Manage to add a
shortcut for the page.

Shortcut

The following shortcut types are available:
l

l

l

l

No shortcut. Creates a link that displays the content you have created. By selecting this, you can also reset the page after using other
types of links.
Shortcut to another content item. Links to another page on the
same website. A visitor who clicks this link is transferred to the page
you have linked to, and kept within the same navigation menu structure.
Shortcut to page on another website. Creates a link to an external
page or to a document on the server. Include the entire URL address,
including https://.
No shortcut, display text only. Creates a heading with no link in
the menu, without displaying any information or link to another page.
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Property

Description
l

Fetch content from another content item. Creates a link to
another page from which content is retrieved into the original page
within the same navigation structure. Useful when re-using content
on the website, in which case you only need to maintain it in one
place.
Note: When you select Fetch content from
another content item, you do not fetch the
entire content of a content item. You only
fetch content into empty properties. For
example, if your source item has a "Page
description" property that you want to reuse
by using a shortcut, your target item must
have a "Page description" property as well and
it must be empty. If the target item's "Page
description" property is not empty, the content is not overwritten; the source item keeps
the old page description.

From the administrative interface, you can customize and configure default values for
selected properties, or to make certain properties mandatory for editors to fill in. See Properties in the CMS Administrator User Guide.

Optimizely Commerce-related content
On an e-commerce website, content can be catalog entries such as products and variants
if you have Optimizely Commerce installed. Editing this type of content is similar to the
editing of pages and blocks in CMS. See Managing content in the Commerce user guide.

Assets
Assets can be content of the type media files, images, documents, blocks or products from
the catalogs in Optimizely Commerce. Assets are available from the assets pane in both
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CMS and Optimizely Commerce, making it easy to drag-and-drop items, such as images,
blocks or products into a CMS page.
You can work directly with content from the assets pane, such as edit images or blocks, or
create folders to organize content items. The context menu will provide different options
depending on the type of assets selected. How to work with content items in the assets
pane is described in the following topics:
l

Folders

l

Media (images, videos, documents)

l

Blocks

l

Commerce catalogs in the Commerce User Guide
Tip: See Best practices for organizing assets for tips on where to
store your assets and how to name them and so on.

Note: By default, the assets pane contains Blocks and Media with
the addition of Catalog entries for Optimizely Commerce. Since the
assets pane is a plug-in area, there might be other asset types available in your view.

Folders
Folders in the assets pane in Optimizely are used for organizing content, such as media files
(images, videos and documents), and blocks. You can have folders with content that can be
shared between all websites in a multi-site scenario (so called global folders), or you can
have folders with content that will only be available for a specific website, page, or block
(so called site-specific or local folders).
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Note: Media and blocks share the same folder structure. This means
that if you create a folder under Media, the same folder is also created under Blocks.
Depending on your implementation, you may have the following predefined folders:
l

l

l

For All Sites. This is called a global folder. Its content is available to all pages and blocks
for all websites in a multi-site installation.
For This Site. This is called a site-specific folder. Its content is available only on the current website (regardless of it is a single or multi-site installation).
For This Page or For This Block. This is called a local folder. Its content is available only
for a specific page or block and cannot be accessed from other pages or blocks. It is useful, for example, if you have images for a specific purpose which must only be used for a
one page or block.
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Note: If you have saved an image in the local folder and then copy
the page content, including the image, and paste it into another
page, you may still see the image in the page. However, this is due to
browser caching, the image is not copied to the new page's local
folder and the link is in reality broken.
Local folders are not available for catalog content in Optimizely Commerce.

Creating, renaming and moving folders
l

l

l

To create a new folder, select the desired folder in the structure under which you want to
add a new folder. Select New Folder in the context menu, and provide a name for the
folder.
Select Rename in the context menu for the folder you want to rename, and enter a new
name.
Use drag-and-drop or Cut/Paste to move folders in the structure.
Note: Renaming or moving folders does not cause any broken content links on your website, but might break incoming links from other
websites or indexing from search engines.
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Deleting folders
Select the folder you want to delete, and select Move to Trash in the context menu. The
folder with its content will be moved to Trash, from where it can be restored. Local folders
cannot be deleted.
Tip: Since blocks and media files share the same folder structure,
removing a folder affects both the block and the media structure.
You are notified about existing references to the content, before
removing it.

Setting access rights for folders
The predefined global folder is available to everyone by default. Local folders inherit the
access rights from the content (page or block) to which they are associated. It is possible
to define access rights for specific folders in a structure. Setting access rights for folders is
done from the admin view in Optimizely, in the same way as for pages in the page tree
structure.

Managing folders in multiple languages
Folders are not language specific, and the folder structure for blocks and media will look
the same regardless of the language selected under the Sites tab in the navigation pane.
This means that you cannot create language versions for folders, but you can use a language code when naming them.

Media
Media in Optimizely are images, documents (such as PDF or Word documents), videos, or
mp3 files. Media files must be stored in the media library on the Media tab in the assets
pane to be available in Optimizely CMS. You can either upload a media file to the assets
pane and then drag and drop it onto a page or a block from the assets pane, or you can
drag and drop the file straight from your computer onto a page or block. In this latter case,
the file is automatically uploaded to the assets pane, and is stored in the For this Page or
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For this Block folder. See the Folders topic for more information on how to organize your
files in folders.

Searching for media
Use the search field at the top of the pane to enter search criteria and retrieve media files.
Clicking a search result expands the folder where the file is located. To browse for media
files, click a folder to expand the folders and content beneath it.
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Uploading media
Media files are uploaded through drag and drop from a file location on your computer to
the upload area. You can also click directly in the upload area to add files. Or, you can
select Upload Files in the context menu for the target folder to which you want to upload
files.
Note: You must have Create access rights to the global or site-specific folder under For All Sites/For This Site where you want to upload
a media file, or to the current page when uploading media files to the
local For This Page folder.

Publishing media
If your system is not configured to automatically publish media files when they are
uploaded, you must manually publish, or schedule for later publishing, media files just as
with other items.
Warning: There are a few important things to know regarding
publishing of media files.
l

l

l

If media files should be automatically published on upload, you must have
Publish access rights for the folder where you upload the files. See Access
rights in the CMS Administrator User Guide.
When a media file is automatically published, it may be immediately indexed
by search engines and can thereby by found in searches. This is worth remembering if you are uploading sensitive information that should not be accessible
until a set time, such as an annual report.
If a content approval sequence has been set on your media folder, or if you
have a project enabled when uploading media, media files are never published
automatically.
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Inserting media
You can add links to uploaded media files, or insert images and embedded media such as
videos. See also: Adding links and Adding and editing images.

Previewing media
Media files in list views are represented by thumbnail images. Common image file formats
are rendered for preview by default in Optimizely, but other rendering formats can be
developed.

Downloading media
Select the desired media file in the Media structure, and select Download in the context
menu. Or, if you are previewing the media file, select Download this file from the Options
button.

Editing metadata for media
Available metadata fields depend on the implementation; images can have photographer,
description and copyright information. Select Edit for the desired media file in the Media
structure, and then the All properties editing view to edit the metadata properties.

Renaming media
Select the media file in the Media structure and then the All properties editing view, and
change the Name and the Name in URL.
Note: Renaming a folder or media file changes its URL. This does not
break internal links on the website, but incoming links from external
websites may break.
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Replacing media
To replace an existing media file with another, upload a new file with the exact same name
to the same folder as the file you want to replace. A replaced media file is published immediately, affecting all places on the website where the file is used.
Note: If you change the name property, the file name in the database is changed as well. If you rename an image, for example, from
Button1.png to Button1, and you later want to overwrite this image,
you have to upload an image with the name Button1 without the file
extension. Otherwise it will be uploaded as a new file.

Note: When replacing images, the changes may not be immediately
visible due to website caching. Refresh the page to see the changes.

Managing media file versions
Versions for media files are managed in the same way as for other types of content, that is,
by using the Versions gadget. See Publishing and managing versions.

Blocks
Blocks are pieces of content that can be reused and shared between websites, while
being maintained in one place only. Typical types of content blocks are campaign teasers
and banners, videos, news feeds and contact forms. Just like for pages, you can have different block types, such as an editorial block, or a form or page listing block.
Blocks are managed from the Blocks tab under the assets pane in Optimizely CMS, where
you can create new blocks and organize them in folders. You can then use blocks by drag-
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ging them into the content area1 of Optimizely CMS pages. You can manage block versions like other types of content, and blocks can also be personalized to be displayed for a
selected visitor group2.

Finding the block location
Use the search field at the top of the pane to enter search criteria and retrieve blocks. Clicking a search result will expand the folder where the block is located. To browse for blocks,
click a folder to expand the folders and content beneath it.
If you have an already inserted a block in the rich-text editor and you want to find out
where it is stored, select the block in the editor and a Go to block button is displayed.
Click this button to open the block or hover over it to see where the block is stored.

1Where you can drag and drop pages and blocks, and create a block. (A link collection has a

similar area for creating links.)
2Site visitors with something in common, such as age, geographic location, and so on. Used in
the personalization feature of Optimizely CMS. (See Personalizing Content.)
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Views when creating and editing blocks
Blocks can be created and edited in different types of views; either in the On-page editing1 or All properties editing2 views which both open the block in the main content area.
They can also be edited in the Quick edit view3 which opens the block in a pop-up dialog
box.
Using the first option, On-page or All properties editing view, you can see all properties
belonging to the block and you can drag and drop images from the assets pane and so on.
Using the second option, Quick edit view, you can edit the block without leaving the current context and relevant properties are found in the same view (which properties you see
depend on your site configuration). If no approval sequence has been set up for the block,
you can also publish your changes directly from the Quick edit view.

1Where you can edit selected properties for content in a WYSIWYG-like view. (See All prop-

erties editing view for comparison.)
2Where you access and edit all properties for content. (See On-page editing view for comparison.)
3The Quick edit view can be used when updating blocks. It lets you see all relevant block properties in one dialog box and you do not have to leave the page context.
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Block editing in On-page/All properties editing
view:

Block editing in Quick edit
view:

Creating a block
Note: You must have Create access rights to the global or site-specific folder under For All Sites/For This Site where you want to create
a block, or to the current page when creating a block in the local For
This Page folder.
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Creating a block from the Blocks tab in the assets pane
When using this option, you can choose where to save the block in the block folder structure. If you save it under For All Sites or For This Site, the block is available for other pages
on the website. If you save it under For This Page, it is only available for use on the current
page. Creating a block from the assets pane will use the On-page or All properties editing
views.
1. Select the folder in the structure where you want create a block, and select New
Block in the context menu, or click one of the New Block buttons.

2. Select the block type among those that are available, and provide a name for the
block.
3. Depending on the type of block, add content as appropriate.
4. Publish the block immediately or schedule for publishing later. Unpublished blocks are
not visible to visitors, and appear dimmed out in edit view when added to a content
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area.

Creating a block directly from a content area
When using this option, the block is saved in the For This Page/For This Block folder for the
selected page or block, which means that it is not available on any other pages on the website.

1. Click Create a new block in the content area, from the On-page or the All properties
editing view.
2. Select the block type among those that are available and give the block a name.
3. Depending on the type of block, add content as appropriate.
4. Click Create. If there is an approval sequence set on the page or if you do not have
publish rights, the block is created as a draft, otherwise it is immediately published.
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Editing a block
Note: Changes made to a block that is being used in content on the
website affect all instances where the block is used.
You can edit blocks directly from the content area where it is being used, or from the
Blocks tab in the assets pane.
1. Select the desired block to edit. Select either Quick Edit from the context menu to
open the block in Quick edit view, or Edit to open it in On-page or All properties editing view.
2. Depending on the type of block, change the content as appropriate.
If you want to rename the block, use the All properties editing view.
3. Depending on which view you are using, as well as the system configuration and your
access rights, you have the following options:
l

l

In Quick edit view, save the block to return to the page, or set the block to Ready
for Review, Ready to Publish, or publish your changes immediately.
In On-page/All properties editing view, set the block to Ready for Review, Ready
to Publish, or publish the block immediately. In these views, you can also schedule
it for later publishing.

Using blocks in content
Blocks can only be added to content areas that support blocks. In edit view, select the
desired block in the assets pane, and drag it into a content area of a page. A blue frame
indicates where it is possible to add blocks on the page.
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You can add several blocks to the same area. Drag the block above or beneath an existing
block, and drop it when the separator appears. The blocks can be rearranged later. It is
also possible to add blocks to a content area in the All properties editing view.
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Note: Like blocks, pages from the page tree can also be dropped
into a content area. Depending on how the page template is built,
the content of the selected page is rendered in the content area.
Blocks can also be added to a rich-text editor area through drag and drop.

To remove a block from a content area, select Remove from the context menu.
Tip: You can personalize blocks to display targeted information to
selected visitor groups, see Personalizing content. Personalized blocks
are not displayed in the edit view. Select a content area to display
personalized blocks.

Note: You cannot link to blocks since they do not have a web
address (URL). However, you can create links to other pages and
media files if the block contains the rich-text editor (XHTML string
property).
Arranging blocks in a content area
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You can change the display order of blocks by rearranging them in the content area,
through drag and drop, or by selecting Move up or Move down in the context menu.

Displaying blocks in different styles
You can select display options for blocks on a page in different sizes and styles. The rendering of blocks needs to have built-in support for managing different widths, in order for
the content to be properly displayed.
The following options are available:
l

l

Automatic. Select this option to display the block using an appropriate built-in style
option selected by the system.
Manually. Select this option to display the block using the specific style option, such as
Full, Wide, or Narrow presets for the specific context where the block is used.
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Moving, copying and removing blocks in folders
Moving, copying and removing a block works in a similar way as for pages by using the context menu. Since blocks and media files share the same folders, removing a folder from the
tree structure affects all content within the folder. If any block or media within a folder is
used on the website, you are notified about the usage before the content is moved to
trash.
Note: A block is no longer available on the website once it is moved
to trash. You can see removed blocks by selecting View Trash from
the context menu of the block gadget.

Versions, content languages and access rights for blocks
l

l

l

Versions for blocks are managed in the same way as for other types of content. When you
update the properties for a block, a new version will be created, which will be listed in the
versions gadget. See Publishing and managing versions.
Content languages for blocks are managed in the same way as for other types of content, see Translating content.
Access rights can be defined for creating and viewing blocks. This is done directly for a
specific block in the All properties editing view, or for an entire block structure from the
admin view. From code it is also possible to restrict the block types that can be added to a
content area. See Setting access rights from edit view in this user guide and Access rights in
the CMS Administrator User Guide.

See also Self-optimizing block in the Optimizely User Guide.

Best practices for organizing assets
When organizing your assets, the top priority is to always follow the standards set by your
organization, as this makes it easier for both yourself and other editors to find already
uploaded assets. Following a standard lets editors search for assets, instead of having to
browse for them. Make sure your standards are documented where all editors can access
them.
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If you are free to set your own standards, here are some tips on how to best organize your
assets. Do the best you can from the start, with input from others as needed. But remember that you can modify how blocks and media files are organized in the future should the
need arise. It will not be done without effort, but perhaps with less pain than you anticipate.

Where to store your assets?
It is critical that the folder structure is simple and intuitive so that editors can find what
they are looking for.
Remember that the same structure is used for both blocks and media assets, so if you create a new folder under Blocks, the same folder is automatically added under Media; you
can read more about that in the Folders topic. If you would like to have different structures for blocks and media files, you can work around the default behavior by creating two
top-level folders, one for Blocks and one for Media. Then use the Blocks folder only for
blocks and the Media folder only for media files.
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The order of folders and the content in the folders in the assets pane is determined by
their names. See How to name folders and assets? for tips on naming folders and assets.
Global or local folder
You can store assets in three containers, each can contain any numbers of folders. These
containers are called For All Sites, For This Site, and For This Page (For This Block, if
you are on a block and not a page). Read more about these containers in the Folders
topic.
l

l

Store your assets in a global folder (that is, For All Sites or For This Site) if they should be
available for use in multiple places. Logos, icons, and teaser blocks are often used in several places and so are often stored in global folders.
Store assets in a local folder (For This Page/For This Block) if they should only be used in
one place. Images related to news, campaigns, events and so on are often just used once
and can be stored in a local folder.

Access rights
The folder structure should be set up so it is possible to control who can create, update
and delete assets. Access rights can be set on the folder structure and on specific users or
user groups. But it is also possible for developers or admins to limit the types of blocks or
assets editors can create, and which block types can be added to which page types.
Uploaded assets can either be automatically published or required to be reviewed and
published separately from the upload process. See Publishing media for more information
on this setting.

How to name folders and assets?
These naming guidelines apply to both folder names and names of individual assets, such
as block names.
Use folder and asset names that clearly describe their content, such as "AlloyMeet_women_
spring_campaign_2020.jpg". An image name such as "img_12345678_a.jpg" is not helpful for
other editors.
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Start off with general area folders and add sub folders with increasing levels of detail, for
example, Products/Alloy Fashion/Campaigns/Womens/2-for-1/teaser_images.
Sorting folders and assets
Folders and assets are sorted in this order in the assets pane:
1. Names starting with an underscore
2. Numerically
3. Alphabetically
This means that folder "_TeaserImages" is sorted first, followed by folders "1_Logos", "2_
Images", "Images" and last "Logos".
Knowing how the folders are sorted helps you to organize assets in a folder structure
based on folder names.
Grouping assets in folders
The grouping of assets in folders can follow different principles, or a combination of these
principles. You have to work out what is best suited for your type of website, organization,
and so on. Here are some examples:
l

l

l

l

Group folders by page tree structure. If your page tree structure is based on the toplevel pages for "Product A", "Product B", "Events" and "Contact us", mimic that structure in
the assets pane.
Group folders by usage. Another way of creating a structure for assets is by grouping
them by their type of usage, for example, folders for “Campaigns”, “Banners”, “Buttons”,
and “News”.
Group folders by brand or product area. Group assets to folders by product areas, such
as “Clothing”, “Shoes” or even product name level for scarves, ties, hats and so on. If you
run an Optimizely solution with multiple sites and want to reuse assets between the sites,
create brand folders under For All Sites.
Grouping folders by language. You might prefer to distinguish assets by language to
keep track of them, especially if you are running culture-specific campaigns with images.
In this case, create an EN folder for all English campaign images, an FR folder for French
assets, and so on.
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l

Grouping folders by access rights. If several editors are working with the content on the
website, you might only have access rights to specific parts of the page tree. Therefore,
you would want to have your own folders in the assets pane as well.

Keeping it clean
Organizing things is not only about adding things; it is also about keeping things up-todate and removing things that are not used. Keep your assets fresh by having a routine for
deleting or archiving unused assets.

Finding content
Follow these tips to find Optimizely content within edit view1.
What you know

Action

Content location within
page, asset or block
structure

Use the page tree structure or the blocks and media assets pane and
select content.

Content location on
the website

Use the preview option, go to the content on the website.

Content is associated
with a project

If you are using the projects feature, use the project overview or the project items navigation pane.
Use the global search in the top menu or the search fields at the top of
the navigation and assets panes.
l

Text within content
title or body

l

The global search can search all types of content on the website
(depending on the configured search provider).
Search fields in navigation and assets panes search for content in
respective pane and related dialogs.

See Search.

1A section of the user interface where you edit content items, such as pages and blocks. To

access edit view, log in and select CMS > Edit. (See admin view for comparison.)
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What you know

Action
Use the Tasks tab to find all content in that status.

A page's status (for
example, draft)

Content was edited
recently

Use the Recently changed status in the Tasks tab.

© Optimizely 2022

70 | Optimizely CMS Editor User Guide 2022-03-14

Creating content
Content can be pages or blocks in Optimizely CMS, or catalog entries in Optimizely Commerce. This topic describes creating types of content in Optimizely.
For further enhancing your content, see topics on how to:
l

add different types of links and shortcuts

l

add and edit images

l

create web forms using Optimizely Forms in the online Optimizely User Guide

Creating a page
You create a page from page types that contain the properties where information is
added.
1. In the page tree structure, select the page under which you want to add the new page.
2. Select New Page from the context menu or the add button on the toolbar.
3. Select a page type from the list of available page types, and provide a name for the
page.
4. Add information in the various properties available for editing, such as the rich-text
editor if this is part of the selected page type.
5. Preview the page before sending it for approval or publishing it.
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Creating a block
You create a block in a similar fashion as a page, by selecting a predefined block type that
contain properties where information is added. For more information on working with
blocks, see the Blocks topic.
1. Create a block from the assets pane, directly from content areas in pages or from the
add button in the toolbar.
Note: If you add a block directly from the content area, it is saved
in the For This Page folder, which means that it is available only
on the selected page and cannot be used on other pages.
2. Select a block type from the list of available blocks.
3. Provide a name for the block.
4. Add information for the block.
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Optimizely Commerce-related content
On an e-commerce website, content can be catalog entries such as products and variants
if you have Optimizely Commerce installed. The creation of this type of content is similar to
the creation of pages and blocks in CMS. See Managing content in the Optimizely Commerce User Guide.

Editing content using the TinyMCE rich-text editor
The TinyMCE rich-text editor is a property where you can enter information such as text
with formatting, images, tables and links to other content. The rich-text editor is used for
both pages and blocks in Optimizely CMS, and for catalog content if you have Optimizely
Commerce installed.

Note: The Optimizely Digital Experience Platform contains many features to support you in your daily work. Depending on how your solution is set up, some features described in this documentation may
not be available to you. Contact your system administrator to find
out more. See Optimizely World for technical information.
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The TinyMCE editor is highly configurable, and a developer may have configured it so that
it looks different on different page types on your website. There are also a number of plugins that may have been added to your editor, but these are not described in this user
guide. The Optimizely sample templates come with a standard selection of activated editor
functions (buttons) as shown in the image above. For more information on the specific
TinyMCE implementation on your website, contact your administrator.
You can drag and drop blocks into the editor area, and pages from the page tree to create
links. Spell checking is available from the browser you are using, or through the Spell
checker add-on from Optimizely.

Formatting
The Paragraph option displays a drop-down list with predefined style formats retrieved
from the CSS style sheets on the website, to be used when formatting text.

You can extend the styles list to include specific formatting for an introduction text, a predefined table layout, or to position images with floating text in the editor area.

Keyboard shortcuts
You can use many of the standard keyboard shortcuts in the rich-text editor.
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List of common keyboard shortcuts
The following standard keyboard shortcuts are supported in the rich-text editor:
Command

Shortcut keys
Windows

Mac

Select all

CTRL+A

CMD+A

Undo

CTRL+Z

CMD+Z

Redo

CTRL+Y

CMD+Y

Bold

CTRL+B

CMD+B

Italic

CTRL+I

CMD+I

Underline

CTRL+U

CMD+U

Copy

CTRL+C

CMD+C

Cut

CTRL+X

CMD+X

Paste

CTRL+V

CMD+V

H1–H6 headings

ALT+Shift+1–6

CTRL+ALT+1–6

Paragraph break

Enter

CTRL+O

Line break

Shift+Enter

Shift+Enter

Focus to toolbar

ALT+F10

ALT+F10

Insert link

CTRL+K

CMD+K

Toogle fullscreen

CTRL+Shift+F

CTRL+Shift+F

Find and replace

CTRL+F

CMD+F
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Note: Depending on customizations and the browser you are using,
certain shortcuts may not work as described.

Adding links
Links are used on websites to link to content. In Optimizely CMS, the following link types
are available by default.
l
l
l
l
l

Page. Links from one page to another on the same website.
Media. Links to images, documents and other media files stored on the web server.
Email. Links to create an email message with the linked email address entered.
External. Links to content on other websites or media on file shares.
Anchor. Links to sections within a page, allowing readers to jump between topics on a
page.

You can also use shortcuts, a specific type of link used for navigation and reusing existing
website information. See All properties editing view.

Creating a link
You can create a link in the rich-text editor through drag and drop (pages and media files),
or by selecting text and clicking the Insert/edit link button in the toolbar, which displays
the Create link dialog box.
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l
l
l

Link title displays as descriptive text for the link, such as on mouse-over.
Open in lets you display the link in a new window, often used for links to external sources.
Language lets you link to a specific language version for content. Automatic directs visitors to the detected browsing language version.

Overview of creating different types of links:
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Create link:

How to:

Detailed info, see:

to page in CMS

Drag and drop from page tree.
or
From Create link dialog box, select Page or
External link.

Linking to a page on the
same website

to page on another
website

From Create link dialog box, select External
link.

Linking to a page on an
external website

to file in CMS

Drag and drop from Media folder.
or
From Create link dialog box, select Media.

Linking to files in Media

to file on file server
or another website

From Create link dialog box, select External
link.

Linking to files on a file
server or an external website

to email address

From Create link dialog box, select E-mail.

Linking to an email
address

to specific location
on a page (anchor
link)

Insert anchor from toolbar, and then from
Create link dialog box, select Anchor.

Creating anchor links

from image

From Create link dialog box, select any of the
Page, Media, E-mail or External link option.

Linking from an image

Linking to a page on the same website
You can create internal links in two ways:
l

l

Place the cursor in the rich-text editor where you want the link, and drag the desired page
from the page tree into the location. The page name becomes the link name (which you
can edit, if needed).
Or, select the text where you want the link in the rich-text editor, and click Insert/edit
link. In the Create link dialog box, you can select the Page option and browse to a page to
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link to, or select the External link option and paste a web address (URL1) to a page on
your website. If you choose the External link option, Optimizely automatically converts
the link to an internal link.

Remaining URL
The Remaining URL field is used to add, or edit, query string parameters. A query string is
a dynamic part of a link and is not related to the website structure. It can be data from a
logged in user, data from a form submission, search result data and so on. A typical URL
containing a query string can look like this:
https://www.alloyexamplesite.com/Search/?searchQuery=reseller. The query string parameters (in bold) following the URL open the search results for "reseller".
To create an internal link containing query string parameters, create the link in the Create
link dialog using the External link option and pasting the entire web address with the query
strings parameters or using the Page option. In that case, browse to the page and then add
the query string parameters under Remaining URL.

1Stands for "Uniform Resource Locator". Also known as a web address such as http://-

world.optimizely.com.
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Linking to a page on an external website
Select the text where you want the link in the rich-text editor, click Insert/edit link, and
use the External link option to enter the web address to the website to link to, such as
https://www.alloyexamplesite.com.
If you create an external link to a page found on the website you are working on, for
example, by copying and pasting a URL from the website, Optimizely recognizes this and
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automatically converts it to an internal link. If the link contains query strings parameters,
the query string parameters can be edited in the Remaining Url option. See Linking to a page
on the same website.

Linking to files in Media
You can create links to media in the Media folder in two ways:
l

l

Place the cursor in the rich-text editor where you want the link, and drag the desired file
(PDF, Word and so on) from a Media folder into the location. The filename becomes the
link name (which you can edit, if needed).
Select the text where you want the link in the rich-text editor, click Insert/edit link and
use the Media option to select a media file to link to.
Note: You can create a link to any type of document, but the behavior when a website visitor clicks the link depends on the file format
and the settings of the visitor's computer.

Linking to files on a file server or an external website
Select the text where you want the link in the rich-text editor, click Insert/edit link and
use the External link option to add the path or URL to the file to link to. For a file server,
enter the complete path including the computer name, and the filename with file extension. The file storage network location must be properly accessible for this to work. Valid
external prefixes are http, https, ftp and file.

Linking to an email address
Select the text where you want the link in the rich-text editor, click Insert/edit link and
use the email option to enter the email address to link to. When you click the link, the
default email client opens with the email address entered in the address field of the email.
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Linking from an image
Select the image in the rich-text editor, click Insert/edit link and add a link using any of
the Page, Media, External link or Email options.

Creating anchor links
When you add an anchor, first create the anchor and then add the link to it from the
Create link dialog box.
1. Place the cursor in the text in the rich-text editor where you want to place the anchor.
2. Click Insert > Anchor on the editor toolbar and enter a name for the anchor. Do not
use special characters or spaces.

3. Select the text in the rich-text editor where you want the link to the anchor.
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4. Click Insert/edit link and use the Anchor option to select the anchor to link to.

Link properties
The following examples show common implementations of link functionality on websites,
with functionality similar to what is described for the link dialog box above.

Image link
When you add images to content areas intended for images or blocks and so on, instead of
adding the image in the rich-text editor, you can use an image link property which lets you
select an image from a folder in Media, automatically placing it properly in the content
area. See Adding and editing images.

Link collection
A link collection is a property where you can manage a group of links.
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You can create links by dropping pages or media files in the link collection area, or by creating links through the link dialog box. You can create links for pages, media files, external
sources and email addresses. You can move links to change the order in which they
appear.
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You can also edit the displayed name of the link.
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Linking to catalog entries
If you have Optimizely Commerce installed, the link dialog box contains an option to select
items from the product catalog when you create links. See Manage content in the Optimizely Commerce user guide.

© Optimizely 2022

86 | Optimizely CMS Editor User Guide 2022-03-14

Adding and editing images
A web page does not embed images, instead it links to the media library where images are
stored. To display images in your content, the images must be available in a folder under
Media in the assets pane. You can either first upload an image to a folder in the assets
pane, and then add it to your content, or you can drag and drop an image directly from
your computer to a content area. In this latter case, the image is automatically uploaded
and stored in the For This Page (or For This Block) folder.
You can edit images inside Optimizely using the Image Editor, providing basic image editing features such as cropping, resizing and transforming.

Adding images to content
In image link property
Images are often added to content through an image link property. You can either drag
and drop an image from the assets pane or from your computer to the property. If you drag
and drop from your computer, the image is automatically uploaded and saved in the For
this Page or For this Block folder in the assets pane. See Media for information on how to
manually upload images to the assets pane.
To replace an already added image, click the image and the Select Image dialog box
opens. In this dialog you can select another already uploaded image or upload a new
image. You can also replace the current image by simply dragging and dropping another
image into the image property.
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In rich-text editor or content areas
You can also add images to the rich-text editor or content areas in pages or blocks. To
add an image this way, you can drag and drop the image directly from your computer into
the rich-text editor. The image is automatically stored in the For This Page (or For This
Block) folder with its original file name. Another way is to first upload the image to a folder
under Media in the assets pane and then add the image through drag and drop from the
folder, or by using the Insert/edit image
button on the toolbar in the rich-text editor.
1.
2.
3.
4.

Place the cursor in the editor area where you want the image.
Click the Insert/edit image button on the editor toolbar.
Select the desired image in the Source folder structure.
Enter an Image description for the image. It is added as an HTML <a> tag to the image
and this is important when a reader has turned off the display of images in the browser
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or when a visually impaired user is using a screen reader.
5. Click Ok.
Note: The TinyMCE editor supports the following image
formats: jpeg, png, gif, and bmp.

Aligning images
You can align images so that they are aligned to, for example, the right and the text wraps
around the image to the left:

1. Place the cursor at the end of the text you want to wrap around the image.
2. Drag and drop the image onto this location.
3. Select the image.
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4. On the editor toolbar, select Format > Align > Right:

Finding the image location
If you have an already inserted image in the rich-text editor and you want to find out
where it is stored, select the image and a Go to media button is displayed. Click this button to open the image or hover over it to see where the image is stored.
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Editing images
Do one of the following to access the Image Editor options:
l

In an image link property, click in the image property to open the Select Image dialog box,
and select Open in Image Editor from the image's context menu:
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l

l

In the rich-text editor, select the image and then click Image Editor in the toolbar.

Locate the image under Media in the assets pane, and select Open in Image Editor from
the context menu.
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Image editing features include cropping, resizing and transforming:
Image editing

Description
Enter values for Top, Left, Width and Height, or draw a selection in the
image to crop.

Crop

Note: Remember to click Apply to save the
changes before proceeding.
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Image editing

Description
You can apply Preset values if such values have been configured for the
website.
Enter values for Width and Height, or move a corner handle to resize, keep
Constrain proportions selected to retain the image proportions.
Note: Remember to click Apply to save the
changes before proceeding.

Resize

You can apply Preset values if such values have been configured for the
website.
Transform

Flip or rotate the image, or select Grayscale to convert to grayscale.

You can save an edited image file as a copy, or replace the original file:
l

l

Save as a copy. If the image was selected in a page or block, the copy is saved in the
local folder. If the edited image was selected in the media structure, the (renamed) copy
is saved in the same folder as the original.
Replace original image. This action affects places on the website where the image is
used.
Note: Selecting the Edit option in the context menu for an image
lets you edit the metadata, which for an image can be photographer,
description and copyright information and such. See Media.

Removing images from content
For an image in:
l
l
l

an image property, click Remove .
a content area, select Remove in the context menu.
the rich-text editor, click the image and delete it.
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Note: Removing an image makes it disappear from the content, but it
remains in Media.

Working with web forms
Web forms are excellent ways of collecting information and interacting with visitors to your
website. Typical examples of web forms are polls and surveys, registration forms, and contact requests. See the Optimizely Forms add-on, which lets you work with form components in a similar fashion as, for example, when dragging blocks into a content area.
If you are on an older Optimizely CMS version, using the legacy built-in form feature, see
version 18-2 or earlier of the Optimizely User Guide.

© Optimizely 2022

96 | Optimizely CMS Editor User Guide 2022-03-14

Collaboration between editors
Most website content is produced by different editors, and on some websites, content or
other changes need to be reviewed and approved before they can be published. To facilitate collaboration between editors when creating content and between editors and
reviewers when approving changes, Optimizely comes with a commenting functionality.
You can add comments on content items and on projects, and you can also tag colleagues
who are then notified of your comment.
Comments are a good way of adding information about changes you have made or asking
other editors to review the item. Other editors can view your comments and reply to them,
and also add their own. Email notifications may be sent out to let you know of other editors' actions.
Note: Comments are connected to a specific version of an item. If
you delete an item version, all comments on that version are also
deleted.

Adding comments
Commenting on content items
You can add comments on any type of content item. A real-life scenario might be when
you are working on an item that needs to be reviewed, and you want to let the reviewers
know exactly what has been updated.
You add and view comments in the comment panel. It is opened and closed by clicking the
comment symbol in the top toolbar. The icon is black when the comments panel is hidden,
and blue when it is visible.
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If you are using the Content approvals feature, an administrator may also have made it mandatory to add a comment when you set an item for Ready for Review. In that case, the following dialog box is displayed when you send something for review:

Adding a comment to a content item:
1. Open the content item. You need access rights to the item to view and post comments.
2. Click the comment symbol
in the top toolbar to open the comment panel.
3. You can either add a comment in the top comment text box to add a comment on the
content item itself, or click Comment on one of the item's actions. For example, if the
item has been sent for review, you can add a comment on the review request action.
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4. To tag another editor, enter @ followed by their user name. Select the user from the displayed list of suggested users. You can tag any of the available users but the tagged
user still needs access rights to the project item to see the actual comment.
Tagged users are notified in the user interface of comments.

5. Press Enter or click Post.

Commenting in projects
You can add comments on a project itself or on specific project items or actions.
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Note: If you go to the project overview to read a comment, the project is automatically activated. If you do not want to continue working in the project, you have to deactivate it again.
Image: Comment on project

Image: Comment on project item
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Image: Reply to comment on project item

Adding a comment to a project or project item
1. Select the project in the project toolbar and click Overview.
2. To add a comment to a:
l
l

Project. Select the Project Comments tab in the project overview.
Project item. Select the Items tab in the project overview and then Show comments. Select the project item you want to comment on. Items that already have
comments are marked with a yellow comment icon .

3. Add a comment in the comment text box. If you add a comment on a project item, you
can either add it to the item itself or click Comment on one of the item's actions.
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4. To tag another user, enter @ followed by the user name. Select the user from the displayed list of suggested users. The tagged user receives a notification in the user interface, and depending on the system configuration, may also receive an email
notification. You can tag any of the available users but the tagged user still needs
access rights to the project item to see the actual comment.
5. Press Enter or click Post.
Image: Comment on project

Image: Comments on project item
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Replying to a comment
Click Reply on the comment you want to reply to and enter your comment in the text box.
Press Enter or click Post.

Editing a comment or reply
You can edit comments and replies that you have created yourself. Click Edit on the comment or reply you want to change. Press Enter or click Save. Edited comments or replies
are marked with a pen symbol .

Deleting a comment or reply
You cannot delete comments or replies yet.
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Managing content
Content can be pages and blocks in Optimizely CMS, or product content from the catalog
on an Optimizely Commerce site. Content can also be assets such as images and videos, or

documents in Word or PDF format. Optimizely has sophisticated version management features, allowing multiple editors to work with draft versions, before approving and publishing
the content.
Content on a website can originate from different sources, depending on where on the site
and by whom it was created.
l

Editors and marketers, or merchandisers can create content internally, on an e-commerce

l

website.
A visitor community member can create content externally through interactive social features on the website, if these are available.

Managing content tasks:
l

Finding content

l

Translating content

l

Personalizing content

l

Previewing content

l

Comparing versions

l

Structuring the website

l

Deleting and restoring content

You can preview draft content before publishing, so that you can verify the content before
publishing. When working with personalization1, you can preview content the way it
appears for different visitor groups. To further limit access to content that is work-in-progress, you can also set access rights for content from the edit view.

1Adapt content to customized target groups for a more personalized website experience, such

as displaying different content to first time and returning visitors. (See visitor groups.)
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If you have content in multiple languages on your website, Optimizely has advanced features for managing translation of content into additional languages, including the use of
fallback and replacement languages.

Optimizely Commerce-related content
See Managing e-commerce-related content in the Optimizely Commerce User Guide, if
you have Optimizely Commerce installed.

Optimizing content to improve search
See Working with content to optimize search in the Optimizely Search & Navigation User
Guide, if you have Optimizely Search & Navigation installed.

Working with multiple languages
Many large websites display content in several languages. Optimizely has powerful support for multi-language management, including the possibility to translate content into a
wide range of languages, defining fallback languages for non-translated content, and switching language for the editorial user interface.
How does Optimizely know which language to display to visitors? Optimizely enforces the
language to be visible in the URL, in the path or the domain part of the URL. When a website visitor selects a language option (if available), content in that language appears. Alternatively, the preferred content display language may be detected by the browser used by
the visitor. If content does not exist in a selected language, a fallback procedure may be
applied.

Enabling content languages
Usually a website has a default or master content language set up at the time of installation. In addition to the master language, your website may be set up with multiple other
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content languages. An administrator enables languages; see Managing website languages
in the Optimizely Administrator User Guide.
Administrators can also set up different access rights to different languages. This means
that you may have access to English and French content, but not to German and Spanish.
l
l

See Translating content to translate CMS content into different languages.
You can also use the Languages add-on for translating content.

User interface languages
The Optimizely user interface is available in a number of different languages. To set the
desired user interface language for CMS, click your user profile name in the upper right
corner. Select My Settings > Display Options tab. At the Personal Language drop-down
list, select the language of your choice, and click Save.

Optimizely Commerce and multiple languages
See Multi-language management in the Commerce section to work with multiple languages if you have Optimizely Commerce installed.

Optimizely Search & Navigation and multiple languages
See Optimizing multiple sites and languages to work with multiple languages if you have
Optimizely Search & Navigation installed.

Translating content
When an administrator has enabled the desired language, you are ready to translate existing content, or create new content in a specific language. Content here can be, for
example, pages or blocks on an Optimizely CMS website, or product-related content on an
e-commerce site. When a language is enabled in Optimizely, content properties that are
not global are available for translation. See also Global properties.
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Note: To prevent editors from accidentally creating content in the
wrong language, access rights can be set differently for different languages by an administrator. If this is implemented, you can only edit
and create content in languages to which you have access.
See also the Optimizely Languages add-on to extend the functionality in Optimizely for
translating content into multiple languages.

Switching language and viewing language versions
To switch language in CMS, go to the Sites tab in the navigation pane and select the
desired language to work with. The user interface reloads, displaying the page tree in the
selected language.
If your master language1 is English and you switch to German, all pages that are not yet
translated into German are displayed in italics in the page tree and with the en language
code for English. Pages that exist in German are displayed in normal font.

To view only pages that were translated, select Show Content in Current Language
Only from the page tree's Settings button. This filters out all other language versions. You
can also use this option in the assets pane and in the Versions gadget to view blocks and
versions in the current language only.

1The language in which the first version of content is created.
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Note: When you show content in one language only, you can move
pages to another location in the page tree structure by drag and
drop or copy and paste, but it is not possible to sort pages. Sorting is
disabled since sorting in one language, where you may not see all
pages, can cause unexpected results in other languages.
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Tip: The setting Show Content in Current Language Only is
enabled for each pane or gadget instance individually. This means
that you, for example, can add the Versions gadget twice and display
only the current language in one of the instances and all languages
in the other.
You can also switch languages by selecting the desired language in the Header, when editing translated content in the All Properties view. The user interface reloads, displaying
the content in the selected language.
When you translate content, you can use the Versions gadget to see the different language
versions for the content. By selecting a language in the version list, you can also switch to
editing in another language using the switch option in the notification bar.

You can search for all language versions for some content by typing a keyword in the
search field for Pages or Blocks in the assets pane.
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Previewing content in different languages
Using the view settings
in the top menu, you can preview and edit content in one of
the languages that are available for translation on the website.

Deleting language versions
To delete one or more language versions for content, select Delete Version or Delete All
[language] Versions from the More options button in the Versions gadget.
Warning: Deleting one or more language versions cannot be undone.

Translating existing content
The Sites tab displays the languages available for content creation, with the default language for the website at the top. Languages that are enabled on the website but are not
enabled for editing, are shown in italics.
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Translating a page
By default, all pages in the tree structure are displayed in the Pages tab, including those
that are not translated. These are shown in italics. To only see pages for the chosen language, select Show Content in Current Language Only.
Do the following to translate a page:
1. Under the Sites tab in the navigation pane, select the desired target language for
translation. The interface reloads, and you are taken to the Pages tab.
2. In the page tree, select the desired page to translate, and then click Translate in the
notification bar at the top. Or, select Translate in the context menu for the page in the
page tree.

3. You can use the compare view
to translate in one pane while seeing the original version in the other pane at the same time.
4. Edit the content and follow the content publishing flow to save and publish the translated page.

Translating a block
You can access language versions for blocks from Blocks in the assets pane. By default, all
blocks are displayed, including those that are not translated; these are shown in italics. To
only see blocks for the chosen language, select Show Content in Current Language
Only.
To translate a block:
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1. Under the Sites tab in the navigation pane, select the desired target language for
translation, and the interface reloads.
2. Expand the assets pane and select Blocks.
3. In the block structure, select the desired block to translate, and then the Translate
option in the context menu.

4. You can use the compare view
to translate in one pane while seeing the original version in the other pane at the same time.
5. Edit the content and follow the content publishing flow to save and publish the translated block.

Global properties
Depending on your implementation, some properties may be globally shared and you can
edit them in the master language1. These properties are marked as non-editable when
editing the content in another language. Switch to the default language if you need to edit
these. The default language is usually the first language listed next to Languages in the
header when editing in the All Properties view.

1The language in which the first version of content is created.
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Creating new content in another language
To create content in a language other than the master language, select the desired language under the Sites tab. Then select the page branch or folder where you want to create the content, and create a new page or a new block. Add content and follow the
content publishing flow to save and publish.

Optimizely Commerce and multiple languages
See Multi-language management in the Optimizely Commerce user guide for information
about working with multiple languages if you have Optimizely Commerce installed.

Fallback languages
For many multi-language websites, only parts of the website content exist in all available
languages because translations may not be ready, content is not relevant for a specific language, or that some content should display in a defined language.
You have the following options:
l

l

Unless a fallback or replacement language is defined, content is invisible to visitors browsing the website in a language into which content is not translated.
Define a fallback language, in which the content appears until the content is available in
the desired language.
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l

Define a replacement language, in which content appears regardless of the language in
which the content exists. If you define a replacement language for some content, a fallback language does not apply.
Note: Fallback and replacement languages may cause mixed languages to be displayed on the website.

Setting fallback and replacement languages
Fallback and replacement languages are defined from the All Properties edit view, when
editing a page or a block and then selecting Tools and Language Settings.

Note: Language settings are inherited from the parent page. If you
are redefining language settings for a subpage to a parent page with
language settings defined, you need to deselect Inherit settings
from the parent page "xxx" in the Language Settings dialog box,
to define settings for the subsection.
Example: fallback language
In this example, the master website language is English, and Swedish, Danish and Norwegian are enabled languages. Content is first created in English, and then translated into
Swedish, Norwegian and Danish in that order. Swedish is used as first fallback for Norwegian and Danish. If content does not exist in Swedish (not translated yet), then a second
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fallback language English is applied.

Example: replacement language
This example shows a multi-language website with a legal information section with content
that should be displayed in English. To ensure this, a replacement language is applied for
the legal information page branch.

© Optimizely 2022

Managing content | 115

Another scenario for using replacement language is when you have started to translate
content on your website, but do not want to have mixed languages until translation is completed. When translation is ready, you simply remove the replacement language.
See also
l
l

Translating content about translating Optimizely CMS content into different languages.

Optimizely Languages in the online user guide about extending the functionality in Optimizely for translating content into multiple languages.
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Personalizing with visitor groups
One way you can a digital experience in Optimizely is to create a visitor group1 with criteria for that group. For example, you can design a product banner specifically for firsttime visitors2, or for visitors from a geographic region or market. For information about visitor group criteria, see Administering visitor groups in the CMS Administrator User Guide.
In Optimizely CMS, you can personalize any type of content in the rich-text editor and in a
content area; personalize part of a text, an image, or a block in the CMS rich-text editor, or
personalize an image, a block or a page in a content area, if you have these in your web
pages.
If you have multiple visitor groups, a visitor may match more than one visitor group. You
then can use personalization groups to group content to avoid displaying the same content twice, and display fallback content to visitors who match no visitor groups.
The preview option in the top menu lets you preview the personalized content as the visitor groups will see it, before publishing.

Applying personalization
In the rich-text editor
1. In Optimizely CMS, open the page for editing, and select the content you want to personalize in the editor area.
2. Click Personalized Content

in the editor toolbar.

1Site visitors with something in common, such as age, geographic location, and so on. Used in

the personalization feature of Optimizely CMS. (See Personalizing Content.)
2Someone who visits a website using a web browser. In most cases, a visitor can use public
functions and services but cannot create content and has limited access to community content. In an SEO context, visitor means the number of visits to a URL through channels (external
referrers), direct arrivals, and internal links. (See also visitor groups.)
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3. Select one or more visitor groups from the list.

4. Preview the personalized content to verify the result. To do this, click

>

.

In the content area
1. Open the page for editing, and select the content you want to personalize in the content area.
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2. Select Personalize from the context menu.

3. Select one or more visitor groups from the list.
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4. Preview the personalized content to verify the result. To do this, click

>

.

Editing and removing personalization settings
In the rich-text editor
Click edit for the personalized content, and update the personalization settings, or select
Remove Personalization.

In the content area
Expand the desired Personalized Group section and click the desired visitor group link to
edit the settings. To exclude content from personalization1, drag it outside the group, or
select Move Outside Group in the context menu.
Example: displaying content to multiple visitor groups without fallback
In the rich-text editor

The non-personalized text at the top of the rich-text editor in this example is always displayed. The personalized text appears only to visitors matching any of the visitor groups
UK visitors and US visitors.
In the content area

1Adapt content to customized target groups for a more personalized website experience, such

as displaying different content to first time and returning visitors. (See visitor groups.)
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In this example, Returning visitors see one block, and First time visitors see another. Visitors that do not match any group do not see anything in this content area.
Example: displaying content to multiple visitor groups with fallback
You want to display specific price information to visitors from the UK and US, and other
price information to visitors from other countries. To avoid displaying price information
twice for visitors from the UK and US, you need to use a personalization group for fallback
content.
Note: The order in which the personalized content is placed within a
personalization group does not matter, but placing the fallback content at the end makes it easier to follow the personalization flow.
In the rich-text editor
Select the fallback1 price information text and personalize it without selecting a visitor
group. Instead create a Pricing personalization group and apply this.

1the default action if no criteria is met; without a fallback, no action occurs.
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Personalize the price information texts for the UK and US visitor groups, and also include
them in the "Pricing" personalization group. The personalization group appears to the
right.
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Now the personalization for this content is matched within the same personalization group.
In the content area
This example shows pricing information as individual blocks, and the Default pricing is the
fallback content displayed to visitors from other countries than the UK and US. Select Personalization in the context menu for a block to create a personalization group, and drag
the other blocks into the group.
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Personalize each block within the group by applying the appropriate visitor group. Use the
Everyone option to display the fallback content displayed to visitors not matching any visitor group.
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Search engine indexation and visitor groups
Search engines crawl your website to index your content. So what if your content is personalized through visitor groups, what will the search engine crawler see? It all depends on
how the visitor group is assessed at the point of crawl. If you have a visitor group Visitors
from the UK , the crawler will index the content personalized for UK if the crawler has an IP
that is identified as being in the United Kingdom. Otherwise that content is not indexed.
Another example is where a date/time visitor group criteria has been applied. If you have a
Weekend only visitor group, then the content will be indexed if the crawler comes along at
the weekend, otherwise not.
It is good practice to have Everyone content in a group, if it is important that something is
shown (or crawled) in a area of the page.

Providing access to content using visitor groups
Administrators can also grant access to specific content using visitor groups. For example,
the administrator can make a page or a block accessible only to visitors from the UK, by
providing access for the UK visitors visitor group; see Access rights in the CMS Administrator User Guide.

Personalizing Commerce content with visitor groups
If you have Optimizely Commerce installed, there are additional visitor group criteria available specific for e-commerce scenarios. See Commerce-specific criteria in the User Guide.

Personalizing with connector add-ons and visitor
groups
You can also personalize content through marketing automation connectors, if you have
Marketo installed on your website, for example. See examples in the following video tutorials.
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Video tutorial: Personalizing content with Optimizely and the Eloqua database. (2:15
minutes)
Video tutorial: Personalizing content with Optimizely and HubSpot. (2:34 minutes)
Video tutorial: Personalizing content with Optimizely and Marketo. (2:56 minutes)

Previewing content
In Optimizely, you can preview content while you are editing to view content as visitors will
see it when published. Preview hides the surrounding on-page editing frames and panes
and you can go through your website.
The preview option can display different things depending on how you are working with
Optimizely CMS:
l

l

You are not using projects or you are using projects via the projects gadget. The
preview option displays the published version of each page, or if there is a newer draft, the
primary draft version. You may have a draft version in a project that is not set to primary
draft, in which case the preview does not display the project version. Use the View settings > Projects option (see table below for details) to view your website as if the items
included in a project were published.
You are using the projects feature. The preview option displays the active project. If no
project is set as active, it displays the published version of each page, or if there is a newer
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draft, the primary draft version.

Use View settings
Options

to preview content with the following options:
Button

Description

Languages

Select a language to view the content as visitors using this language will see it.

Visitor groups

View the content as the selected visitor group will see it.

Media channels

Select a channel and/or a resolution to see the content as it will
appear with the selected settings. The options are customized for
your website.
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Options

Button

Description
Navigate and view the contents of a project to verify the display
before publishing.

Projects

Note: This option is not available if the
projects feature is enabled. In that case,
the preview button displays the active
project. To preview another project, you
need to change the active project.

Note: You can combine previewing with the view setting options to
display French content (for example) as visitors using a mobile
device and with German as preferred language will see it.
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Comparing versions
In the compare view in Optimizely you can compare content and properties between specific versions to see what has changed. When you compare content, the On-page edit view
displays two page versions side-by-side. Properties are compared in the All properties edit
view.
Toggle the Compare different versions button on the toolbar to turn the compare view on and off.
The Select compare mode button appears in the compare view and shows the
selected compare mode; that is, if you are comparing content or properties. This
selection is sticky, which means that whatever mode was used the last time you
did a comparison is preselected the next time you turn on the compare feature.
Click this button to display a drop-down list where you can change compare mode:

The notification bar displays two drop-down lists from which you can choose which versions to compare. By default, the draft is shown in the left pane and the currently published version in the right. All language versions of the content are listed by default.

Comparing content
When you compare content, the On-page edit view shows two versions side-by-side. You
can scroll and resize the panes.
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When you edit a published version in the left pane, a new draft is created and displayed in
the version list. It works in a similar way as you edit content directly on the page, and when
you are done, you can publish a draft, or republish a previous version.

Comparing language versions when translating content
The current language is selected in the language selector list, and you can filter the versions by language. You can compare versions made in the same language, or in different
languages.
By comparing versions made in different languages, you can translate the content in the
left pane side-by-side with the published version of the current language. You can also
jump between languages to edit by selecting the current language in the version list of the
left pane, and then switch language on the notification bar.
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Comparing properties
When you select to compare all properties, the All properties editing view displays the two
compared versions of the properties side-by-side. They are displayed in the same tabs as
they usually are, with the exception of the Basic info properties, which are displayed in a
tab of their own instead of in the Basic info area. Tabs that contain changes between versions are highlighted with a yellow digit; the digit identifies the number of changed properties there are on the tab between the two compared versions.
In the compare properties view, the two property versions appear side-by-side. The latest
version of the property is shown first, to the left of or above the older version of the property. All properties that differ between the two versions are highlighted with a yellow background.
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You can edit the latest version of the properties, and if you decide that you prefer the
older version to the newer, you can click Copy and the older version is used in the newer
version also. When you edit a published property, a new draft appears in the version list.

Setting access rights from edit view
Administrators generally manage website access rights from the administration view.
However, if you have administer rights, you can set access rights for a single page or a
block from the edit view. This is useful when you need to publish an item to verify the final
result, but you do not want it to be publicly visible.
Note: If sub items are set to Inherit settings from parent item,
these items are also affected by your change.
To set access rights, open the item in the All properties edit view (or scroll to the top of the
page in the on-page edit view). The Visible to option displays Everyone for content that is
publicly available on the website, and Restricted if access limitations apply.
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Click Manage to change the settings in the Access Rights dialog box:
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If access rights are inherited from the parent page, clear Inherit access rights from parent item, and click Add Users/Groups to define new access rights. Add access rights as
desired and save the settings.
For example, removing read access for Everyone, as in the example above, hides the published page from the public, but it is fully visible and editable for the Site_Editors group
(and Administrators).
Note: You must belong to a group with Administer access rights to
define access rights from the edit view. This setting does not provide
access to any other administration options in Optimizely CMS.
See Access rights in the CMS Administrator User Guide for information about working with
access rights in Optimizely CMS.

Structuring the website
In the Optimizely CMS, the page tree structure is located in edit view under Pages. At the
top of the structure is the root page, usually with one or more start pages directly underneath. The structure of the website is made up of pages. By default, the page structure is
reflected in the navigation menus. To simplify navigation, limit the submenu structure to a
maximum of three levels.

Page tree
By hovering over a page in the tree structure, information about the page appears, such as
ID and page type. A set of page tree symbols provides additional information about the
structure. Note that some of these icons are only displayed for the first draft version of a
page, before any published version exists.
The root page.
Start page.
Published page. See Working with versions.
Page that links to another page on the same website. See Shortcut to page
in Optimizely CMS under Shortcut in Working in All properties editing view.
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Page that links to an external website or a specific address. See Shortcut to page on
another website under Shortcut in Working in All properties editing view.
Page containing a shortcut that is not linked anywhere; it only displays the text and is
used to create a heading with no link in the menu. See No shortcut, display text
only under Shortcut in Working in All properties editing view.
Page that fetches and displays content from another page on the same website. See
Fetch content from page in Optimizely CMS under Shortcut in Working in All
properties editing view.
Container page used for storing other pages; not visible on the website.
Draft of a new page; not visible on the website yet. See Working with versions.
New page scheduled for publishing; not visible on the website yet. See Working with
versions.
Expired page; not visible on the website anymore. See Working with versions.
Page that is set to Ready to Publish. See Working with versions.
Page that is set to Rejected. See Working with versions.
Page is currently In review and must be reviewed and approved before it can be published. See Content approvals.
Previously published page; not visible on the website anymore. See Working with
versions.
Page locked for editing for the logged-in user.
Page being edited by another user. You can see who by hovering your mouse over
the icon.
Published page. Note: This icon appears for project items; not in the Pages navigation pane. See The projects feature.
You do not have the rights to publish this item or the specific item version does not
exist anymore. Note: This icon appears for project items; not in the Pages navigation
pane. See The projects feature.
Note: Your website might be customized with other symbols implemented by the partner developer.
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Moving, copying and removing pages
Moving a page
Use drag and drop to move a page, or select Cut in the context menu for the page you
want to move, and select Paste for the destination page. You can also move pages by
using the keyboard commands CTRL+X for cut (on Mac: CMD+X), and CTRL+V for paste (on
Mac: CMD+V).
Note: When you move a page, internal links are redirected to the
new location and are not broken. However, any external links pointing to the moved page will be broken.

Copying a page
Press CTRL (or on Mac: Option) on your keyboard and drag and drop to copy a page, or
select Copy in the context menu for the page you want to copy, and then select Paste for
the destination page. You can also copy pages by using the keyboard commands CTRL+C
for copy (on Mac: CMD+C), and CTRL+V for paste (on Mac: CMD+V).
Subpages and associated media files in local page folders are copied also, and the links
point to the new copy of the page. Settings, such as dynamic properties and categories,
are copied also with the new page.
Note: When you copy and paste a page under the same node, the
Name in URL property of the copied page is typically named Name
in URL1, which you need to change after copying.

Removing content
Removed folders, pages, blocks and media files are moved to trash, and are not publicly
available on the website. Remember to update any links to removed content. When you
remove a page, all underlying pages are removed also. See Deleting and restoring content.
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Sorting page order in menus
The pages in the tree structure are sorted according to a predefined sort order. By default,
the page that was created most recently is placed at the top of the tree structure, for
example, in news listings. There also are other options for sorting, such as alphabetically or
by sort index. The last option lets you control the sorting through an index defined on each
page.

The sort order is set for the parent page of a branch, and is inherited by the subpages:
1. Select the parent page of the branch in the structure where you want to set the sorting.
2. Edit the page and select the Settings tab.
3. Select sorting criteria under Sort subpages.
4. Publish the page for the changes to take place.
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Sorting according to sort index
If you want to control exactly how the pages in the structure are sorted, select the According to sort index option for the parent page. Then give each child page a unique sort
index number, and they are sorted in ascending order according to their number, with the
lowest number on top.
Change the sort order of pages by dragging the page and dropping it where you want it in
the tree structure. Sorting pages with drag and drop is only of interest for branches that
are sorted with sort index.
l

l

If you move a page into a branch that is not sorted according to sort index, you get prompted to move the page and at the same time apply sort index as sort order for that branch.
Confirm with OK. When you drag a page into a new position in a page tree branch, the sort
index is automatically recalculated to fit the sort order of that branch.
If you drop a page under a different parent page (with sort index set as sort order), the
page is first moved or copied, and then sorted. The page remains in the tree in the position
where it was first dropped.
Note: The pages that you move are saved again, meaning that you
must have publishing rights to use drag and drop for sorting. You
also must have publishing rights for the page branch with sort index
to which you move a page.

Sorting according to sort index manually
You can set the sort index manually for each child page. Open the page for editing, select
the Settings tab and change the number in the Sort index box. The sort index number
must be an integer, but there are no other restrictions. Work with whole tens or hundreds
to insert additional pages in between existing ones in the structure. Publish the page to
apply all changes to the structure.
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Deleting and restoring content
Optimizely has advanced support for restoring deleted content such as pages, blocks,
folders and media files. When you remove content, you move it to trash; you do not delete
it. From there, you can restore the content or permanently delete it.
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Note: Optimizely Commerce does not support trash management
when deleting catalog entries.

Moving content to trash
Select the content to delete, and select Move to Trash from the context menu.
Content that is moved to trash is automatically unpublished from the website. When moving content to trash, you receive a notification if the content is linked to from other content on the website, because the deletion might result in broken links.

Note: Content versions are not supported by trash management. So,
when deleting a version in the versions gadget, the version is permanently deleted.
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Restoring content
Select View Trash from the pane settings in the navigation or assets pane. Hover over the
desired content item in the list and click Restore. The content is restored to its original
place and republished. You must restore content to edit it.

Deleting content permanently
Select View Trash from the pane settings in the navigation or assets pane. Click Empty
Trash to delete the trash content permanently (may require administrative access rights).
You can automatically empty the trash at a regular time interval using a scheduled job.
If you want to delete just one single item, hover over the item and click Delete. Note that if
that single item has children, these children will also be deleted permanently.
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Working with versions
Optimizely has sophisticated support for advanced management of content creation and
publishing involving multiple editors. The draft concept is central, ensuring that work-inprogress is never externally exposed until it is actively published. The publishing options
you see depend on the content status and your access rights. Available actions, content
status and notifications are indicated in the status bar at the top.
Publishing involves steps from creating a draft to publishing the final version, and managing versions. The steps apply to different types of content such as pages, blocks and
media, or products if you have Optimizely Commerce installed on your website.
Video tutorial: Publishing content (4:18 minutes)
See also: Controlling the publishing process.

Publishing actions
When you create or update content, you can perform a number of actions to create drafts,
undo changes, set content ready for review, publish directly or schedule publishing at a
later stage, and so on.

Creating drafts and autosaving
Whenever you create new content or edit existing content, a draft version is automatically
created. This is not publicly available on the website until actively published. Changes to
content properties are immediately autosaved by the system. Versioning is not used for
drafts, which means that you and other editors can work on the same draft over time but
you still will have only one version of the draft.
You can manually create a draft from a previously published version or from a version that
is scheduled for publishing at a later time. This is done from the Options menu.
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Undoing and reverting to published
While editing, clicking the Undo option in the page information area lets you undo changes
to content that was previously autosaved.

l

Select Undo to discard the changes done since the last autosave.
Note: You can only undo changes you have made during the current editing session. As soon as you move to another page, close
the browser, log out, and so on, the history of actions that can be
undone is emptied.
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l

l

Select Redo if you discarded your changes through Undo and want to take them back
again.
Select Revert to Published to go back to the latest published version, if the content was
previously published. Note that this deletes your current draft and you need Delete
access rights for this option. It is also available on the Publish menu.

Previewing and comparing
You can preview content appearance using the Preview mode option in the top toolbar.
You can also preview content by language, visitor group or display channel if these are
used on your website; see Previewing.
You can also compare different content versions by using the Compare version option in
the top toolbar; see Comparing versions.

Publishing
When done editing, click Publish? at the top and then Publish (or Publish Changes, if you
are editing previously published content). The content is immediately published and publicly available on the website, provided that no access restrictions apply. Click View on
website to view the content as it appears on the website.
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You can also republish on older version of a page, see Managing versions.
If you want to publish the page at a later time, see Scheduling for later publishing.

Publishing for different time zones
The time for publishing is determined by the local time zone of the editor who publishes or
schedules a page. This means that if you are working as an editor in London, UK, and you
want to publish page A at 8 AM New York time and page B at 8 AM Tokyo time, you need to
find out what the corresponding time is in London. In this example, you would have to publish page A at 1 PM and page B at midnight UK time.

Setting Ready to Publish
If you do not have publishing access rights, or if you want your changes to be approved by
someone else before publishing, use the Ready to Publish option to mark the content as
ready for approval and publishing. Withdraw and Edit lets you take back content for further editing after sent for approval.

Setting Ready for Review
If your site is set up to use content approvals, your content may have to be approved by
one or more approvers before it can be published. In that case, you do not have the Publish? option, and you have to set the content to Ready for Review when you are done.
Doing this starts the approval sequence. When all approvers have approved the content,
you are notified and you can publish the content or schedule it for late publishing. See
Content approvals.
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Approving content
If you are an appointed reviewer for a content item, you can approve changes for the content item when it is in status Ready for Review and at the approval step where you have
been set as reviewer. You can also decide to decline the changes, in which case the content version status is set to Rejected. This does not mean that the latest changes disappear, only that the content needs to be edited and reviewed again before it can be
approved and published. You can monitor content status and related tasks under Tasks in
edit view.
If you have Administer rights to the content item, you can also approve the entire approval
sequence and also cancel the review request.
See Content approvals for more information.
Image: Dialog box without Administer rights
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Image: Dialog box with Administer rights

Scheduling for later publishing
If you have publishing access rights, you can schedule the publishing to occur at a later
occasion. Select the Schedule for Publish option, and set the date and time when you
want the content (new or updated) to be published. This applies to both newly created
content, and changes to existing content.

Removing scheduling and creating new drafts
Content that is scheduled for publishing, is locked for editing. Select the Remove Scheduling and Edit option to interrupt the scheduled publishing and continue editing the selected version.
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Selecting New Draft from Here creates a new draft, based on the scheduled version,
which is still published at the scheduled time. You can continue working on the new draft,
and apply publishing actions for this, as desired. An advanced scenario would be to apply
multiple publishing occasions for different versions of a campaign page, having them
replace each other in a desired order.

Managing versions
If you need to backtrack and use an older version of a page or if you are managing multiple
language versions, there are a number of tasks you can perform from the version list by
using the More options button found at the bottom of the version list in the versions gadget.
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Click the column headers to sort the version list according to language, status and more.
Note: You need to add the versions gadget to the navigation or
assets pane to see the version list.

Viewing versions
Content can have the following status in the version list:
l
l

l
l

Draft. Content that is a work-in-progress and is not yet subject to any publishing actions.
Published. The most recently published version and the one publicly displayed. Only one
published version can exist.
In review. Content must be approved before it can be published. See Content approvals.
Previously Published. One or more versions that were published before the latest published version.
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l
l

l
l

Ready to Publish. Content awaiting approval and publishing.
Rejected. The content was set as Ready for Review or Ready to Publish and an
approver has rejected the content. You can edit and update the rejected content and
then set it to Ready for Review or Ready to Publish again.
Scheduled for Publish. Content scheduled to be published at a specified time.
Expired. Content where a stop publish date and time is set and passed. The stop publish
date applies to all versions of a page, which means that you cannot have one version of a
page that is expired and one that is published.

Setting the primary draft
Note: Versioning works differently if you are working with projects.
For a more detailed description on how Optimizely handles versioning in projects, see Versioning when working in projects.
The primary draft is the draft presented in edit view, when accessing the content. Multiple drafts may exist, by default the latest saved edited version is the primary draft.
Use the Set as Primary Draft option in the version list to make another draft the primary
one.
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A content item that is not published can have only one draft. You can create multiple
drafts from published versions, each draft is editable individually and you can schedule for
publishing at different times. There are no versioning of drafts so there is only one version
of each draft.

Editing and deleting versions
The content version selected in the version list is loaded into the editing area, from where
you can edit the content or perform other available publishing actions.
Select the Delete Version option to delete a version. Content versions are not supported
by trash management. So, when you delete a version in the versions gadget, the version is
permanently deleted.
Note: The version with status Published cannot be deleted, to do
this another version needs to be published first. Deleting content versions cannot be undone. You can disable the ability to delete versions in the administration view.

Managing language versions
If the selected content exists in multiple languages, language versions are displayed with a
language code. To filter versions for a desired language, select Show Content in Current
Language Only in the version list.
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Republishing a version
To republish a previously published version, select the desired version from the Versions
gadget and select Republish from the Options menu. When you republish content, for
traceability reasons, a new version with a new timestamp is created, even if no changes
were made.
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Note: You can only republish a previously published version if no
approval sequence has been defined on the content item. If an
approval sequence has been defined, you must select New Draft
from Here, set the new draft to Ready for Review and then let the
draft be approved before it can be published.

Unpublishing content
Unpublished content in Optimizely CMS is content that is not yet published or content
that you for some reason do not want publicly visible on the website.
There is no Unpublishing option in the user interface; instead, you have the following
options to hide published content from being publicly visible on your website:
l
l
l

Set the content item to expired if you want to keep it for reference or future use.
Remove the Everyone access rights to it.
Delete the content item if you do not want to keep it.
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Setting expiration of content
Normally, web content never expires, but you can set pages and blocks to expire at a certain time in the future or immediately. Expired content is not displayed on the website but
remains in Optimizely CMS. You can remove the expiration from the content to make it
appear on the website again.
Note: The expiration sets a stop publish date on the content and this
date applies to all versions of the content. For example, if you set a
page to expired and then create a draft from the latest published
version and publishes that draft, it will still be expired and not displayed on the website. You must manually remove the expiration for
the page to be public.
Setting an expiration time is done in the All properties editing view by selecting Tools >
Manage Expiration and Archiving. Select Now if you want expiration to apply immediately.

Archiving of expired content
Optimizely has a built-in archiving feature where pages with a set stop publish time are
automatically moved to a defined archive branch when the time has passed. This is useful
when you have news pages in a listing where you want to remove old news from the listing,
but still keep the pages in an archive. Note that the expiration date is removed when the
items are moved to the archive to make the archive public.
Archiving expired content is done in the Manage Expiration and Archiving dialog box by
selecting the page branch to which you want to move the expired page.
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Working with shared content
As soon as you start to edit content, the content is marked as currently being edited notifying other editors to avoid version conflicts.

Mark as being edited
Even if content is marked as being edited, another editor can select the Edit Anyway
option, and continue working with the draft.
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Permanently mark as being edited
The currently being edited markup setting is automatically cleared after some time. To
keep this setting, you can set a permanently being edited markup through the All properties editing view by selecting Tools > Permanently Mark as Being Edited. This setting
remains until manually disabled (toggle the setting to disable).

A/B testing
A/B testing lets you create variations for a number of page elements (blocks, images, content, buttons, form fields, and so on), then compare which variation performs best. It measures the number of conversions1 obtained from the original (control) versus the variation
(challenger), and the one that generates the most conversions during the testing period is
typically promoted to the design for that page. Optimizely A/B testing has several predefined conversion goals you can use when setting up a test, and it is also possible for
Optimizely developers to create customized conversion goals.

1When a website visitor takes a desired action. This desired action can be, for example, buying

an item, filling in a form, or clicking a link.
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See also Optimizely Web, a powerful front-end A/B and multi-page experimentation
product.
Note: The Optimizely Digital Experience Platform contains many features to support you in your daily work. Depending on how your solution is set up, some features described in this documentation may
not be available to you. Contact your system administrator to find
out more. See Optimizely World for technical information.
Video tutorial: A/B testing (5:07 minutes)

How it works
Let's say you want to know whether a different advertisement can generate more interest
from your site visitors. Using A/B testing, you create two page versions with two different
advertisements that link to a target page1. You set the A/B test to use the conversion goal
Landing Page, which measures how many visitors click the advertisements and reach the
target page.
1. When a visitor views your A/B test page, the visitor sees the original (A / Control) or the
variation (B / Challenger) version. A/B testing logs which version the visitor sees. If a
visitor returns to the test page, the visitor sees the same version (A or B) throughout
the duration of the test. However, if they clear cookies, and revisit the test page, they
are considered a new visitor in the test.
2. If a visitor clicks the advertisement, the target page appears and A/B testing logs the
action as a conversion.
3. When the test duration completes, the version that achieves the best results (that is,
the most clicks) is declared the winner of the test.
4. Depending on your site configuration, you can manually pick a winner (usually the one
with most conversions) or the winner is automatically published when the test completes. Test winners are only automatically published if test results are statistically significant. For more information on statistical significance on A/B tests, see the Statistical
significance section below.

1The page that defines the end goal of a conversion path.
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Statistical significance
Statistical significance is a calculation that determines if test results can be considered
"significant" or not. It is a function of the number of views and conversions of the variants.
So, if one version is winning by a wide margin but has a relatively low number of views, it
could still be calculated as the statistically significant winner of the test. Whereas a test
with a great many more views, but where the variants' conversion rates run much closer,
could have results that would not be considered significant. Theoretically, statistical significance can be achieved at any point during a test. This is not done here. A/B testing lets
the test finish before running the calculation that determines if the results are “significant”.
So, how many views are needed to ensure statistical significance? The answer is that it
depends on the margin of conversions the winning variant is winning by.
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Confidence level
The confidence level set in Advanced options is used in the significance calculation to specify the amount of variance the results can have before they are considered statistically
significant. The higher the confidence level you select, the more “sure” the calculation has
to be that a variant is winning by a statistically significant margin. This is saying how much
standard deviation the calculation can have before the results are viewed as significant.
Typically, the more data in a test means that the standard deviation goes down, and thus
the confidence % in those results goes up.
Once the test has completed and results are calculated using the selected confidence
level, the reporting appears at the top of the Pick a Winner screen.

Starting an A/B test
1. Start with a published version of a page or block as the original (A / Control). For
example, you have a site devoted to air travel tips and want to get visitors interested in
exploring your site. Will a fancy graphic button get more click-through1 than a plain
text button?
2. Create a draft by changing the button or making some other change to the page:
Image on version A / Control:

Image on version B / Challenger:

3. Select Publish? > A/B Test changes. Do not publish the changed page. The A/B test
view appears showing A / Control and B / Challenger thumbnail images.
If you are using Content approvals, set your draft to Ready for Review and let it be
approved before you start the A/B test.

1Following a hypertext link to a particular website; especially a commerce site.
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4. Configure your A/B test by setting the following options:
Option
Test Goal

Description
Enter your hypothesis for the test. This is for your information only.
Select the conversion goal or goals that you want to measure. (Conversion goals are also known as key performance indicators KPIs1.) You
can add up to five conversion goals for the A/B test, and under
Advanced Options, you can decide if some goals are more or less important than others.
l

l

Conversion
goals

l

l

l

l

Landing Page. Select a target page to which visitor is taken when
the visitor clicks through. Only a click-through is counted as a conversion.
Site Stickiness. Select a target page and a timeout period (1-60
minutes). The A/B test counts a conversion if a visitor goes from
the target page to any other page on your website during the time
period. If the visitor closes the browser then opens your target
page again within the specified time period, a new page view is
not counted. However, a conversion is counted if the visitor goes
from the target page to another page during the second visit.
Time on Page. Enter a time in seconds. The A/B test counts a conversion when a visitor stays the defined time on the test page.
Add to Cart. Select a product a site visitor can add to a cart. If a
visitor adds that product to a cart, it is counted as a conversion.
Average Order. Select this conversion goal to track completed
orders on each of the test pages. The conversion goal totals up
the values of all Optimizely Commerce carts created by visitors
included in the A/B test. The test determines which page variant
creates the highest average value for all those carts when picking
a winner. If a visitor creates multiple carts, all the
(purchased) carts are included in the total, which means that the
visitor can “convert” many times in the test duration. On Optimizely Commerce websites using different currencies, the test converts all carts to the same currency.
Purchase Product. Select a product a site visitor can buy. If a vis-

1Stands for "key performance indicator" (also known as a conversion goal); the measurement of

actions on web pages. The actions can be completed purchases, pages visited, time spent on
site and so on.
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Option

Description
itor buys that product, it is counted as a conversion.
Note: You need Optimizely Commerce to use
Commerce-related conversion goals such as
Add to Cart, Purchase Product, and Average
Order.

Enter the percentage of total amount of traffic to your A/B test.

Participation
percentage

Test duration

If you set it at 100%, all website visitors participate in the test. Half of
the test participants will see version A, and half of them will see version B.
However, you may not want so many visitors to see version B if it
includes something that might be unsuccessful. You accomplish this
by lowering the percentage of visitors included in the test. Visitors not
included in the test will see version A. Only visitors included in the test
count in the statistics.
Specify the number of days you want the test to run.
Select one of the options. You can stop the test at any time before the
number of specified days are done.
l

Start test
l

l

Advanced
Options
l

Start test immediately. Select this option and click Start Test
after you specified the test parameters.
Schedule for later. Select this option and a date picker appears.
Select a date and time to start the test. Click the Schedule Test
button after you specified the test parameters.
Balance the importance of test goals. Select if one goal is more
important, or less important, than the others. If two conversion
goals are set to High (or Low), it is the same as leaving them at
Medium, meaning they have the same importance and thus not
weight the test result. Similarly, if you add a single conversion
goal, the selected weight has no effect on the test result.
Confidence level. Select the confidence level of statistical sig-
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Option

Description
nificance you want from the results that you gather. The higher the

confidence level you select, the more “sure” the calculation has to
be to determine that the winning variant is winning by a statistically significant margin.

5. Click Start Test if you set the test to start immediately, or Schedule Test if you scheduled the test for later.

Viewing a running A/B test
1. To view a running A/B test, open the page you are testing, and click View Test on the
notification bar.

The test results are displayed, and a flame graphic shows which version is leading:
.
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Beneath the two page thumbnails, you can view the currently collected test data, such
as views, number of conversions, and conversion rates. If you are measuring towards
multiple conversion goals, you see how each goal is performing and what weight each
goal is given. If you are measuring towards one goal only, you see the test data and a
pie chart visualizing the conversion rate. The conversion rate can be a percentage rate
or an amount, if you are using the Average Order KPI. (The pie chart is not displayed for
Average Order KPI.)
Note: A/B testing normally calculates the views as the number of
times a page has been displayed to a visitor. However, when you
are testing a block, A/B testing counts the number of times the

© Optimizely 2022

Working with versions | 165

block has been requested by Optimizely CMS. If you have a condition set on your block so it is only displayed to certain visitor
groups, for example, a view may be counted even though the
block has not been displayed to a visitor.

Note: Statistical significance of the test is calculated when the
test is finished. Before that, it is not possible to say whether the
test results are significant or not.
2. You can select the following actions from the Options menu:
l

Pick The Winner. If you see enough data before the test completes, you can stop
the test and pick a winner. For example, perhaps the changed page is a clear runaway winner such that another few days of testing may not significantly affect the
result.
If you select Pick The Winner, the Pick the Winner view appears. The leader is
highlighted in green. Click Pick The Winner and it is automatically published.
After you select a winner, the loser is added to the Versions gadget as a historical
artifact.
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l

Abort A/B test. Stop the test and discard the results.

Picking a winner
Depending on your site configuration, a test winner can be published automatically at the
end of the test, or you can publish it manually, during or after the A/B test.

Publishing a test winner automatically
An administrator can set up your site to automatically publish A/B test winners at the end
of a test, if the test result is statistically significant. If this setting is enabled, it affects all
tests on your site. As soon as a test finishes, the test winner is published. However, if the
test result is not statistically significant, you have to manually publish one of the test versions.

Publishing a test winner manually
If you have publishing rights, you can publish a test winner while the test is running or wait
until it finishes.
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1. To view a finished A/B test, open the page you are testing, and click Pick winner on
the notification bar.

The test results are displayed.

At the top of the test result screen, you can see if the results are statistically significant.
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The test winner is highlighted with a green background and a trophy graphic:
.
The Pick The Winner button of the test winner is green, but you can publish either version.
Beneath the two page thumbnails, you can view test data, such as views, number of
conversions, and conversion rates. If you are measuring towards multiple conversion
goals, you see how each goal has performed.
2. Click Pick The Winner on the version you want to publish and it is published immediately.
The loser is still available in the Versions gadget.

Managing A/B tests
You cannot edit the test settings or the content of a page while the test is running
because you could possibly invalidate the results. If you need to change the test settings
or something on the test page, you must cancel the test, make your changes, and start the
test over. You can cancel the test from the Options menu in the test view or from the test
page. If you open a draft of the test page, the Options menu is called Publish?.
Use the Tasks tab in the navigation pane to find A/B tests.
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Scheduled Tests. Displays links to tests
that are scheduled to run at a later time.
Active Tests. Displays links to active test
pages that are collecting data. Click an
item to display the test page, where you
can click the View test link to display the
snapshot of result data.
Completed Tests. Displays links to completed tests. Data is no longer being collected. A winner has not yet been
published.
Archived Tests. Displays links to completed tests where a winner has been published.
For other statuses in the Tasks bar, see Controlling the publishing process.

Viewing completed and archived tests
In the Tasks pane, you can see all A/B tested pages by selecting Active Tests, Completed
Tests, or Archived Tests. (A completed test is a test that is finished but a test winner was
not yet published. An archived test is a completed test where a test winner was published.)
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To view the individual tests run on a specific page, add the Archived Tests gadget to the
navigation or assets pane and open a tested page. The gadget displays all archived tests
run on the current page. Click a test in the gadget to view the test details.
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Controlling the publishing process
Large organizations with geographically distributed editors often benefit from process support when creating, reviewing, publishing and translating content. Optimizely is built for a
distributed way of working, with various options for managing content creation and publishing depending on the size and setup of organizations.
Ways of controlling the publishing process:
l

Content approvals

l

Change approvals

l

Use Projects to multi-publish items

l

Restrict access rights (see the Optimizely CMS Admin guide)

l

Use the Tasks tab

The following features can be used to control the publishing process:
l

Content must be approved before it can be published
Content approvals is a way to make sure that content is reviewed and approved before

it is published. When an editor has finished working on a content item, the item is set
to Ready for Review. One or more appointed reviewers must then approve the content item before it can be published. The reviewers are defined by an administrator in
an approval sequence.
l

Changes must be approved before they are applied
Change approvals is a way to make sure that certain changes are reviewed and

approved before they are applied. The changes that are applicable for review are
changes that affect how your website looks to visitors, such as moving a page to
another parent item in the structure (as that can affect menus) or changes to access
rights, language settings, or expiration dates.
l

Publish multiple related content items at the same time
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The projects feature and the projects gadget let you preview and publish multiple content items at the same time, such as a landing page, blocks and products (if you have
Optimizely Commerce installed) that are part of a campaign.
l

Restrict publishing access rights
Access rights let you control what editors can do where in the content structure. A
typical example is to restrict the right to publish content to editor groups. This means
that the publish option is not available for editors. Instead, they use the Ready to Publish status option. You can then view the content under Tasks.

l

Use the Tasks tab
The simplest way to monitor content creation activities is to use tasks. The Tasks
option lists changes to content filtered by content status.
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You can use the following options for monitoring content creation and content
approvals:
Option

Description

Draft

Lists all draft versions that have been created or changed by you.

Rejected

Lists all content items in status Rejected that have been created or
changed by you. Items are set as Rejected when they have been set to
Ready for Review or Ready to Publish and then are declined. You can
edit and update content in status Rejected before you set it to Ready to
Publish or Ready for Review again.

In Review

Lists all content items on the website that are set as Ready for Review.
See Content approvals.

Ready to Publish

Lists all content items on the website that are set as Ready to Publish
and that you have publish rights to.

Marked as Being
Edited

Lists all content items on the website that you have set as being edited.
See Tools under Basic information properties.

Recently
Changed

Lists the last items that are changed for the website by you or any other
editor.

Awaiting Review

Lists the content items that you have sent for review and are in content
status In Review.

Declined Reviews

Lists the content items that you have sent for review and are declined
items in content status Rejected. As soon as the item is updated, it is not
displayed in this list anymore.

Approved
Reviews

Lists the content items that you have sent for review and are approved,
that is in content status Ready to Publish. As soon as the item is published (or updated), it is not displayed in this list anymore.

Awaiting Your
Review

Lists the content items that you are one of the designated approvers of.
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Option
Approved by You

Description
Lists the content items you have approved. As soon as the item is published (or updated), it is not displayed in this list anymore.

Clicking a content item in the filtered task list displays the item in the main area. Use
the versions gadget to see the version history for that particular content item. If you
have publishing access rights, you can decide upon further publishing actions from the
versions gadget.
If you are using A/B testing, you see a number of tasks related to this feature in the
Tasks list. The available options under Tasks can also be configured specifically for
your website by a developer.

Content approvals
Content approvals is a way to make sure that content is reviewed and approved before it is
published. When an editor has finished working on a content item, the item is set to Ready
for Review. One or more appointed reviewers must then approve the content item before
it can be published. The reviewers are defined by an administrator in an approval
sequence.
Video tutorials
There are three video tutorials on the Content approvals feature. The first one is a basic
demo of the feature and describes how to set up an approval sequence and a basic review
scenario. The second video describes how you can set up different reviewers for different
languages when you have a multi-language site. It also shows you how content approvals
can be combined with comments and projects. The third video describes how content
approvals work for blocks and media. It also highlights the use of multi-language sites, projects and notifications features.
Content approvals video - basic functionality (7.04 minutes)
Content approvals video - multi-language site (6.21 minutes)
Content approvals video - approvals for blocks and media (6.17 minutes)
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How it works
Sequences and reviewers
An approval sequence can be set up with any number of approval steps and any number of
reviewers in each step. The sequence is set up by an administrator; as described in
Managing approval sequences in the CMS Administrator Guide.
The approval sequence administrator also defines, for each step individually, who can
approve a content item. It is possible to have only one person as reviewer in a step, but it is
recommended to have at least two (per language) in case one of them is unavailable.
Note: The administrator can prevent editors from approving their
own changes, which means that appointed reviewers are not allowed
to approve any review requests they have started themselves.
However, they can still cancel their own review requests.
As soon as one of the reviewers in a step approves the content, that step is considered
completed and the item moves to the next step in the approval sequence. When a content
item enters an approval step, the reviewers in that step are notified by email and in the
user interface that they have an item to approve. The editor who started the approval
sequence is notified when the last reviewer approves the content item and it is set as
Ready to Publish, or if an reviewer rejects the content item. When the content is
approved in all steps, it is automatically set as Ready to Publish, and anyone with publishing rights can publish it.
The approval sequence overview is opened from a page's or assets folder's context menu:
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Editors can normally view an approval sequence but not change it. If an administrator has
set an approval sequence on a node in the page tree, editors without administrator rights
cannot by-pass the approval sequence. The Publish button is replaced by a Ready for
Review button, and setting a content item to Ready for Review starts the approval
sequence.

Content approvals on assets
Each page in Optimizely can have its own content approval sequence. Assets, such as
blocks and media (and also forms and catalogs if you have Optimizely Forms and Optimizely Commerce respectively installed), cannot have individual approval sequences.
Instead, the content approval sequence is set on each assets folder, and all assets in a
folder have the same approval sequence set. Global and site-specific assets folders can
inherit their approval sequence from a parent folder, or an administrator can define a
unique sequence for it (or disable it completely so that assets in the folder do not have to
be approved). Local assets folders inherit their approval sequence from the page they are
associated with. See Folders for a description of global, site-specific and local folders.
What happens if I want to move folders or assets that have content approval sequences set?
Moving folders and assets that have content approval sequences set, works like the following descriptions.
Folders
l

Moving a folder to another global or site-specific folder. The folder keeps its original
approval sequence. You can move the folder even if items in the folder are in review.
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l

Moving a folder to a local assets folder. The folder's approval sequence is changed to
the local assets folder’s sequence. You cannot move the folder if items in the folder are in
review.

Assets
l

l

Moving an asset to a global or site-specific folder. The approval sequence on the asset
is changed to the new folder's approval sequence. You can move an item even if it is in
review. However, it continues its original content approval sequence until it is approved or
rejected. After that it has the same approval sequence as the new folder.
Moving an asset to a local asset folder. The approval sequence on the asset is changed
to the new folder's approval sequence. You cannot move the asset if it is in review.
Note: The Blocks and Media folders in the assets pane are actually
the same folders in the software and share the same content
approval sequences; the Blocks and Media tabs in the assets pane
are merely a way of filtering out blocks if you are in the Media tab
and vice versa. This means that if Adam is set as a reviewer on block
folder Bunnies, Adam is also a reviewer of all media in media folder
Bunnies.
As a result, if you edit a block in the Bunnies folder which links to
images in the media folder Bunnies, and set the block to Ready for
Review, the same content approval sequence is triggered also for
the images.
Forms and catalogs have their own structures, so even if you have a
Commerce catalog named Bunnies, it does not get the same content
approval sequence as the Bunnies folders for blocks and media.

If you are working on a multi-language site, items such as images that do not have a language set can be approved by any reviewer (even by reviewers that only have access to a
specific language). Example: You have a site in English and German (where English is the
master language1) and you have set up the approval sequence so that reviewer Julia is
responsible for the German content items but not the English items. You keep a folder with

1The language in which the first version of content is created.
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the two images Party_teaser_EN.png and Party_teaser_DE.png for an English and a German
version, and Julia is an designated reviewer in the approval sequence on this image folder.
Julia can then approve all images in the folder even if the Party_teaser_EN.png is only used
on English pages, which she does not have access to.
Assets added to an assets folder with a content approval sequence set are not auto published.

Multiple languages
If you have content in more than one language, each language must have at least one
reviewer. The administrator decides whether a reviewer can approve content for all languages or for specific languages. Therefore, it is possible to have different reviewers for different languages.
Each language version can be set as Ready for Review and approved separately from the
other language version. This means that the German version of an item can be approved in
three approval steps and published before the French version has even passed approval
step 1. See Translating content to work with different languages.

Example: Content approval sequence with multi-languages
In this example, there are three reviewers in step 1, one for each of language (this is for simplicity only, in reality you should have at least two reviewers per language). In step 2, there
are two reviewers, who have access rights to approve all languages. If one of the reviewers
declines the content, that language version is set as Rejected and needs to be set as
Ready for Review again.
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Approval rejections
If a reviewer does not approve a page and declines it, the page returns to being an editable draft (with status Rejected). The responsible editor must update the page and set it
to Ready for Review again. The approval sequence then starts over, and the reviewer of
the first step in the approval sequence must approve it again, even if that reviewer had
approved the first draft and it was a reviewer in a later step who rejected the page.

Notifications
If you have started a content approval sequence by setting an item to Ready for Review,
or is set as a reviewer, you receive notifications in the user interface. The bell icon in the
toolbar displays the number of new notifications you have; click the icon to display a list of
notifications. From the notification list, you can go to the item that needs to be reviewed.
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If your system is configured to use email notifications, you will also receive an email; how
often these notifications are sent depends on the system configuration.
Notifications are
sent when:

an item is set to
Ready for Review.

an item was
approved in a step.

To:

Notification message:

"Awaiting your approval or one of
Z others. Step X of Y" (if there are
multiple reviewers in the step) or
the reviewers in the first step.
"Awaiting your approval. Step X of
Y" (if there are only one reviewer
in the step).

the reviewers in the next step.

"Awaiting your approval or one of
Z others. Step X of Y" (if there are
multiple reviewers in the step) or
"Awaiting your approval. Step X of
Y" (if there are only one reviewer
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Notifications are
sent when:

To:

Notification message:

in the step).
all steps were
approved and the
item is set as Ready
to Publish.

to the user who started the content
approval sequence.

"The reviewed content has been
approved and is now ready to publish."

a content approval
step was declined.

to the user who started the content
approval sequence, and to all
reviewers in current and previous
steps.

"Declined by *username*".

a content approval
sequence was cancelled.

to all reviewers in current and previous steps.

"Review request canceled by *username*".

The title of the email shows that it is a review request, and you can see who requested the
review. You can also see the title of the item to be reviewed (Black Friday shoe sale), the
language of the item (en, which stands for English), the item type (Page) and when the
review was started (10/21/2017 3:48 PM). Click Review item to open the item.
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Tasks
Tip: To keep track of the content items you have sent for review,
items that are waiting for your approval or items you have already
approved, use Tasks in the navigation pane.

Options related to content approvals in Tasks
Option

Description

In Review

Lists all content items that are set as Ready for Review.

Awaiting Review

Lists the content items that you have sent for review and are in content
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Option

Description
status In Review.

Declined Reviews

Lists the content items that you have sent for review and are declined, that
is in content status Rejected. As soon as the item is updated, it is not displayed in this list anymore.

Approved Reviews

Lists the content items that you have sent for review and are approved, that
is in content status Ready to Publish. As soon as the item is published (or
updated), it is not displayed in this list anymore.

Awaiting Your
Review

Lists the content items that you are one of the designated reviewers of.

Approved by You

Lists the content items you have approved. As soon as the item is published
(or updated), it is not displayed in this list anymore.

What happens if a reviewer is away and cannot approve?
To avoid content getting stuck in an approval step if a reviewer is unable to approve, it is
recommended that you have at least two reviewers (per language) in a step.
An administrator can approve and publish a page at any time.
Administrators and the editor who started the approval sequence can cancel the approval
sequence at any step.

Example: Content approval sequence in two steps
Web editor Tina works in the Marketing department and has prepared a new product
launch. An approval sequence is set up for the Marketing pages, and when Tina is done,
she does not have the Publish option. Instead, she must set the new product page to
Ready for Review. The page is now locked for further editing and according to the predefined approval sequence, one of the company's chief editors Alicia and Carlos, must
review and approve the page. Alicia and Carlos are notified with an email and also when
they log in to Optimizely CMS that they have a page to approve.
When Alicia or Carlos has reviewed the page, she or he approves it.
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The approval sequence now states that Steve or David needs to approve the page. They
are both notified by email and in the user interface. As soon as one of them has approved
the page, it is set to Ready to publish. The approval sequence is now done and any editor
(or administrator) with publishing rights to the content can publish it. Tina, who started the
approval sequence, is notified.
If Steve or David declines the approval, the content is set as Rejected and Tina must
update it and set it to Ready for Review again. Alicia or Carlos will then have to approve
the second draft as well.

Working with approval sequences
Starting an approval sequence
If an approval sequence is defined for the content you are working on, you cannot publish
directly. Instead, you have to start the approval sequence by clicking Publish? > Ready
for Review.
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When a content item is in review, its status changes to In review in the Versions gadget.
Until it is approved in all steps of the approval sequence, it is locked for editing. When it is
approved in all steps, it is set as Ready to Publish, and you are notified of this both in the
user interface and by email.
Image: Review icon in page tree

Image: Versions gadget shows In review status
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Approving or declining an approval step
If you are set as reviewer for a content item, you are notified in the user interface and by
email (if the system is configured to send out emails) when it is ready for your review. Click
the user notification or the link in the email to open the content item. If there is a previous
version of the content item you want to review, you can use the compare feature to see
where changes have been made.
When you have reviewed the content item, click Approve? and then either Approve
Changes or Decline Changes. You may have to give a reason for approving or declining
the content item.
If you approved the content item, it moves to the next step in the approval sequence, or if
you were the last reviewer in the sequence, it is set as Ready to Publish.
If you declined the content item, it is set as Rejected and the editor needs to update the
content and set it to Ready for Review again.

Tip: If you have multiple review requests to go through, you can use
the Tasks pane to see which items you should review and to go
between them, and the compare feature to see where changes have
been made.
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Canceling an approval sequence
You can cancel an approval sequence that you have started regardless of which step the
content item is in. Click Options > Cancel Review Request and Edit. You can now edit
the content again. When done, you have to set it as Ready for Review and the approval
sequence starts over from step 1.

Commenting when approving and declining content
When approving or declining content and depending on your system configuration, you
may have to give a reason for your action. This comment is visible in the user interface and
email notifications to the person who started the content approval sequence. It is also displayed in the project overview, if the content item in review is associated with a project.
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Change approvals
Change approvals is an add-on to Optimizely CMS, which lets you make sure that certain
actions that affect the website structure or content are reviewed and approved before
they are applied. The actions that can go through change approvals are changes to
access rights, language settings for fallback and replacement languages, and expiration
date, and also the moving of pages and assets such as blocks, images, and media in the structure.
Note: Change approvals are not triggered when a page is moved but
remains under the same parent page, that is, when the page is
moved only to change the sort order.
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Change approvals is similar to Content approvals, which is a feature where the content
must be reviewed and approved before it can be published. You cannot use Change
approvals without Content approvals. Both features use the same approval sequences,
which means that the same reviewers approve changes to both content and to settings
such as access rights, language settings, and so on.
Note: The Optimizely Digital Experience Platform contains many features to support you in your daily work. Depending on how your solution is set up, some features described in this documentation may
not be available to you. Contact your system administrator to find
out more. See Optimizely World for technical information.
Video tutorial: The Change approvals feature. (4:42 minutes)

How it works
Change approvals are done by setting up a content approval sequence which defines the
reviewers. An approval sequence can be set up with any number of approval steps and any
number of reviewers in each step. The sequence is set up by an administrator; as described
in Managing approval sequences in the CMS Administrator Guide.
When an approval sequence has been defined, the approval process is started as soon as a
user performs one of the actions that triggers the Change approvals. Once the process is
started, the change must be approved or declined (or the review request canceled) before
any other change that requires approval can be done.
As soon as one of the reviewers in a step approves the change, that step is considered
completed and the reviewers in the next step of the sequence are notified that they have
a change to review. When all steps in the approval sequence have been approved, the
change is immediately applied.
Example: One-step change approval
Tina has been asked to change the order of the products in the Alloy top navigation menu.
Since the navigation menu order is controlled by the order of the pages in the page tree,
she moves the Alloy Track page in the page tree. The Alloy Track page has an approval
sequence defined so the page is not immediately moved, and Tina sees a message that the
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move of the page is awaiting approval. The approval sequence is set up with one step, and
both reviewers, Alicia and Carlos, are notified in the user interface when they log in that
Tina has moved Alloy Track and that they need to approve that move. Carlos now approves
the move and the page is moved immediately and the top navigation menu is updated on
the website. If Carlos had instead declined, the page would have remained in its original
position.

Setting up an approval sequence
Change approvals use the same approval sequences as Content approvals. This means
that if you have set a content approval sequence for a content item, the same sequence
and the same reviewers, are used when action controlled by the Change approvals feature
is performed on that content item. How to set up content approval sequences are
described in detail in Managing approval sequences in the CMS Administrator Guide.
The approval sequence overview is opened from a page's or assets folder's context menu:
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Note: When setting up an approval sequence, there is a language
setting
. This setting only applies to Content approvals, where it
is possible to set up different reviewers for different languages.
Change approvals does not take this setting into consideration; all
appointed reviewers can approve changes in all languages.

As an editor or administrator, how does Change approvals
affect me?
If you have the access rights to change one of the settings controlled by the Change
approval functionality, you can change settings or move pages and blocks the same way
as without Change approvals. However, after changing the setting, you will see a notification message: Your changes have been saved and sent for approval. The changes will
come into effect once they have been approved. There is also a notification bar in the content item to inform you that a change is in review.

Once a change has been made and it is in review, you can no longer move the item or edit
a setting that requires approval until the review request has been approved, declined, or
canceled. You can cancel the review, and thereby revert your change, by selecting Cancel
review request from the Options menu.
As soon as the last of the appointed reviewers approves the change, the change automatically comes into effect.

As a reviewer, how do I approve or decline a change?
Note: Depending on how the approval sequence has been set up,
you may not be allowed to approve or decline a change you have
made yourself, even you are one of the appointed reviewers.
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1. When you log in to the Optimizely CMS user interface, you will see a notification if you
have a change to approve:

2. Click this notification to see the change detail overview:

In this view, you can see the old value of the setting and the new value. Greyed out values have not been touched; bold are used for new values, and strike-through for
removed values.
3. To approve or decline this change, click the Options menu and select Approve
Changes or Decline Changes:

© Optimizely 2022

Controlling the publishing process | 193

Note: Change approvals does not check if the reviewer has the
access rights to perform the proposed change. It only checks if the
user who makes the change has the access rights. For example, if you
remove the 'Everyone' access rights to a page, Change approvals
checks that you have the right to do so, but the reviewer who
approves the change does not have to have that right.
Email notifications for change approvals have not yet been implemented, so you are only
notified in the user interface when you have a change to review.

Using Content approvals and Change approvals at the same
time
When you have used Content approvals and sent content for review, the content (that is,
the specific version of the content) is locked for editing. You can still move the page/block
and change the language settings. You cannot change the access rights or expiration
date.
When you have used Change approvals and sent a change for review, you can still edit
the content but you cannot move the page/block or change language settings, access
rights, or expiration date.

© Optimizely 2022

194 | Optimizely CMS Editor User Guide 2022-03-14

Projects
A project lets you manage the publishing process for multiple related content items. For
example, you can add a landing page, blocks, pages and products (if you have Optimizely
Commerce installed) to a project and publish them, manually or scheduled, at the same
time. Projects support management of content in different language versions, so you can
manage translation of content items in projects.
In Optimizely, there are two ways to work with projects.
l
l

Use the projects feature. This feature is enabled by default.
Add the projects gadget to your user interface, if the projects feature has been disabled by
a developer.

The following table shows a comparison of the two methods:
Projects gadget

Projects feature

Accessible to users who add the gadget.

Accessible to all users unless it has been disabled for
the website.

Added to your own user interface; does
not affect other users.

Enabled or disabled for the entire site and affects all
users.

You need to add content manually to a
project.

Content is automatically added if a project is active.

Other editors (not using the Projects
gadget) can update content associated
with a project.

Content associated with a project can only be
updated within the context of the project. (If content is
associated to a project, an editor who wants to edit
that content needs to have that project active or create a new draft).

When the project is published, the project
is obsolete and can no longer be used.

You can continue working with a project even after
some or all items are published.

All project items must be set to Ready to

You can publish multiple items that are set to Ready
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Projects gadget

Projects feature

publish before the project is published.

to publish and leave items that are not ready for a
later time.

There are no collaboration features.

You can collaborate on projects by adding comments
to projects and items.

The projects gadget
A project lets you manage the publishing process for multiple related content items, such
as a landing page, blocks and products (if you have Optimizely Commerce installed) that
are parts of a campaign. Projects support content management in different language versions, so that you can manage translation of content items in the project view.
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You can create new content or create draft versions of existing content, associate the content items with a project, and then publish the project immediately or schedule it for later
publishing.
Note: You need to add the projects gadget to the left or right pane
to access the project features.

Working with projects
Creating a project and adding content
Create a project from the gadget menu and add desired content items through drag and
drop. You can prepare the draft versions of the content items first, and then create the project and add them, or the other way around. Use Sort in the context menu to sort content
items for a better overview, and Refresh to reload the view if multiple editors are working
on the same project. Use the Sort button
and the Refresh button
project.

to sort content items for a better overview,

to reload the view if multiple editors are working on the same
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Note: A specific content version can only be part of one project. If
you try to add the same version to another project, you are prompted
to create a new draft.

Previewing project content
The preview option in the top menu has an option for projects where you can browse
through included items, preview them as if they were published, and update them if
needed.

Publishing projects
To publish a project, all included items must first be set to status Ready to Publish. You
can do this for each item from the publishing menu when editing, or from the context
menu in the Project gadget.
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When all items are ready for publishing, you can publish the entire project directly, or
schedule the project to be published later (if you have publishing access rights). If you need
to change content in a scheduled project, select Remove Scheduling and Edit, change
the content and re-schedule the project publishing. Published projects cannot be edited.

Removing content and deleting projects
Remove a content item from a project by selecting the item in the projects gadget and
then selecting Remove from Project from the item's context menu. Removing a content
item from a project means that it is no longer associated with the project but it is not
deleted from the website.
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Delete a project by selecting the project in the projects gadget and then selecting Delete
Project from the gadget's context menu. Projects are permanently deleted, but associated
content items remain. When deleting a project scheduled for publishing, you have the
option to keep or remove the scheduling for each associated item.

Example: Publishing a campaign using projects
This example creates a fashion sales campaign with multiple content items on a website
with Optimizely CMS and Optimizely Commerce. The campaign will go live on a specified
date, and contain a landing page with a product listing block, two new products to be listed in the block, and a teaser block for the start page. You create the project first, and then
add the content items.
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1. In the Optimizely Commerce catalog tree, create a project for the campaign and name
it Spring Collection.
2. Prepare draft versions of the catalog items in Optimizely Commerce, create and edit
the catalog entries and add product descriptions and assets as desired.
3. When done, drag the prepared catalog entries from the Catalog gadget to the Project
gadget where you set the products to Ready to Publish before they are added to the
project, but you can do this later.

4. Switch to the CMS edit view and create the landing page for the Spring Collection.
Add text and assets as needed, and drag the landing page to the Spring Collection project.
5. Create a block listing the products included in the spring collection, and include it in
the landing page. Add the product listing block to the project.
6. Create a teaser block to be used on the landing page for promoting the new spring
collection, and add the teaser block to the project.
7. Drag the teaser block to the start page, and add the start page to the project. The
Spring Collection project now contains all the items to be included in the campaign.

© Optimizely 2022

Controlling the publishing process | 201

8. Preview the content items in the project, edit as needed and set to Ready to Publish
when done.
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9. Schedule the project to be published on the defined go-live date for the campaign.
Note: You cannot edit versions of content items that are part of a
scheduled project. For example, if you need to update the start page
before the scheduled project is published, you need to create a new
draft and then publish this. If you need to incorporate the same
changes into the scheduled project version of the start page, remove
the scheduling to edit.
Example: Managing multiple content language versions using projects
This example creates a page with a registration form block for an event. The included items
need to be available in English (the original website language), French and German, and
you manage the translation using a project.
1.
2.
3.
4.

Create the page and the related forms block in English first.
Create a project and name it Spring Meeting.
Add the English versions of the page and the forms block to the project.
Enable and activate the desired languages (here French and German) on your website,
if not already done. (Must be done by an administrator.)
5. Switch to the French language branch and create a French version for the page and
the forms block.
6. Drag the French version of the content items into the Spring Meeting project.
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7. Repeat the previous actions for the German language version. You now have six content items in the project; two for each language version.

8. Translate the content items into French and German respectively.
Use compare to display the original English version when translating.
l
Use preview to verify the different language versions of the content.
9. Set all the content items to Ready to Publish when done, and publish the project or
schedule it for later publishing.
l

The projects feature
A project lets you manage the publishing process for multiple related content items. For
example, you can add a landing page, blocks, pages and products (if you have Optimizely
Commerce installed) to a project and publish them, manually or scheduled, at the same
time. The projects feature supports management of content in different language versions,
so you can manage translation of content items in projects also.
Note: The projects feature may be disabled on your site, in which
case you do not see the project bar at the bottom of the user
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interface and you cannot use the feature.
Video tutorial: Managing content with the projects feature (5:20 minutes)
Project features:
l
l

The projects feature is enabled or disabled for the entire site and affects all users.
Editing actions, such as creating and updating items, automatically associate a content
item with a currently active project. Exceptions to this rule are moving items in the structure, setting content to expired, changing access rights or language settings. These
actions do not associate content items with the active project.
Note: Remember to deactivate the project when you no longer
want to work with it. Items wrongly associated with a project
need to be manually removed from the project.

l

l
l

l

l

l

You can also manually associate items with a project by dragging and dropping them from
the page view into the project overview.
Content associated with a project is locked for editing if another project is active.
A version of content is associated with a specific project. This means that you can have a
published version of an item not associated with any project; one draft of the same item
belonging to a Summer campaign project, and another draft belonging to a VIP campaign
project.
You can add, remove and update existing items even if some or all of the items within a
project are published.
You can collaborate with other editors by adding comments, and replies to comments, to
project items and to projects.
The project interface consists of three main parts; the project bar at the bottom, the
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overview and the project items navigation pane to the left.

Projects user interface
Project bar
A project bar is displayed at the bottom of the CMS window indicating if a project is active
or not.

When you first access the edit view with the projects feature enabled, no project is selected in the project bar. When you select a project, it is preselected the next time you open
the user interface.
If a project is active—that is, is selected in the project bar—all changes (creating a new
page or block, updating existing content, uploading an image and so on) are automatically
associated with that project.
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If you select the option None (use primary drafts), you can work with content items as
usual without associating them with any projects.
From the context menu on the project bar, you can create, rename and delete projects.

If you delete a project, associated items are not deleted but are no longer associated with
a project.

Project overview
From the projects bar, you can open an overview that displays content items associated
with the active project.

The overview shows details such as name, content status, content type, and time and date
for latest change of each content item.
Each content item in the overview has a context menu from which you can set the item to
Ready to Publish, open it for editing and remove it from the project, providing you have
Edit access rights. The context menu button appears when you hover over an item.
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You can select multiple items in the overview and remove them from the project or set
them as Ready to Publish all at the same time. Common computer mouse and keyboard
functionality for selecting multiple items is supported, except for CTRL+A which is not supported.
From Options in the overview, you can publish all items that are set to Ready to publish
immediately or schedule them for publishing at a later time.
Show comments opens a view where you can select a project item and see a list of events
connected to the item. You can add comments on each event and also reply to comments,
see Collaboration between editors.
Use Sort
to order content items for a better overview, and Refresh
the view if there are multiple editors working on the same project.

to reload

Project items navigation pane
The project items navigation pane provides quick access to items in the project. Doubleclick an item to open it.

Each content item in the project items pane has a context menu displayed when you hover
over an item; the menu options are the same as those in the project overview. You can
select multiple items in the list the same way as in the project overview.
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Versioning when working in projects
Tip: Add the versions gadget to your user interface if you are working
with multiple drafts and projects to see a list of the different versions.
It is only one version of a page that is associated with the project. This means you can
have a published version of a page and several drafts, and any one of these versions can
be associated with the project. If the associated version is the published version, the project overview displays Published for that item. If it is not the published version, the overview displays Draft, Previously Published, Expired and so on.
The Versions gadget shows you which project each version is associated with, which is
especially useful if you are working with multiple projects for the same content:

You can only have one published version, so if you publish another version of the page
(that is, a version that is not associated with the project) after the version associated with
the project, the project version is not published anymore and therefore set as Previously
published in the project overview.
When you open an item and have a project active, Optimizely CMS displays the version
associated with the active project. If you open an item and do not have a project active,
Optimizely displays the version that is set as primary. You can see which version is the
primary in the versions gadget; the primary version is marked with a target symbol . The
primary draft is not necessarily the latest version. See also: Setting the primary draft.
When the projects feature is enabled, versioning works in the following ways:
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Project 'X' is selected

Result

and you create new
content from
scratch:

The draft is created and added to the active project automatically. Because
this is the only version of the content, it is set as the primary draft.
Is the content a draft and associated with the active project?
Yes: The draft is saved and still associated with the active project.
Whichever version was the primary draft before is still the primary draft.
No, the content is a published version or a draft not associated
with the active project: A new draft is created and is associated with
the active project. The previous version is still the primary draft.

and you update
existing content:

Note: If there is a previous draft within the project
in the same language, the previous draft is
replaced with this new draft as only one version
can be associated with a project. The previous
draft remains in Optimizely as a draft but is no
longer associated with a project. A draft of the
same project item but in another language is not
replaced as it is viewed as another version of the
item. This means that you can have one draft in
English and one draft in French of page Z in the
project X, but you cannot have two drafts in English of that page.
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Project 'X' is selected

Result

None (use primary
drafts) is selected

Result

and you create new
content from
scratch:

The draft is created and set as primary draft.

Is the content a draft?

and you update
existing content:

Note: It does not matter if the content is associated with a project or not; versioning works the
same in this case.
Yes: The draft is updated and saved. If it was associated with a project
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None (use primary
drafts) is selected

Result

before you edited the draft, it will still be associated with the project
afterwards. Whichever version was the primary draft before is still the
primary draft.
No, the content is not a draft: A new draft is created and is not associated with a project. It is set as the primary draft.
Note: If the updated content is a media file and
auto publish is turned on, the media is automatically published at this stage.

Working with projects
Creating a project and adding content
You create a new project from the context menu on the project bar.

When you create the project, it is automatically set as the active project. To add a content
item to the active project, make an editing change (such as creating a page, updating existing content, uploading an image and so on), and the content item is automatically associated with the project. You can also drag and drop items from the navigation or asset
panes into the project overview to associate them with a project.
Note: A specific content version can only be part of one project. If
you try to add the same version to another project, you are prompted
to create a new draft. If you choose to create a new draft, the new
version is then added to the project.
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Editing content in projects
You will see a notification if the version you are working on is associated with the active
project.

Content not associated with the active project but with another project is locked for editing. However, even if that version is locked for editing, you still can create a new draft with
the New Draft from Here button in the yellow toolbar. That draft is associated with the
active project, or to no project at all if None (use primary drafts) is selected.

If you open a version of an item that is not associated with a project but has other versions
that are associated with projects, you will see a notification with links to these projects.

If you want to make a change that should not be associated with the active project, you
have to select None (use primary drafts) or another project from the project bar. When
None (use primary drafts) is selected in the project bar, you can create drafts, publish
content and so on, as long as the content version is not associated with a project.
Content items that are part of a project remain so even after they are published.
Uploading media to projects
If you upload media while a project is active, it automatically associated with the active
project.
Note: If you have a project active when you upload a media file, you
must manually publish the media file, even if your system is configured to automatically publish media as soon as it is uploaded.
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Previewing project content
The preview option in the top menu lets you browse through the website as if the project
were published. If you click preview
, you preview the active project; to preview
another project, change the project in the project bar. Previewing a project shows you the
draft associated with the project or, if there is no draft associated with the project, the published version.

Collaborating on projects
You can add comments on project items in the project overview and, for example, ask
other editors to review an item. This feature is described in Collaboration between editors
in the CMS Editor Guide.

Publishing project items
From the project overview, you can publish multiple items that are set to status Ready to
Publish. You can set items to Ready to Publish from the publishing menu while editing an
item, from the context menu in project overview, or from the Project Items navigation pane.
You can select multiple items and set them to Ready to Publish, both from the overview
and the navigation pane. You publish the content items associated with the project, not
the project itself.
Image: Publishing menu
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Image: Context menu, overview

Image: Project Items tab in navigation pane
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When items are ready for publishing, you can publish them directly from Options, if you
have publishing access rights, or schedule the project to be published later.

Note: If the items in a project were scheduled for publishing and you
add new items to the project, the new content is not scheduled for
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publishing automatically. You must specifically set the new content
to scheduled time of publishing if you want it to be published at the
same time as the other items in the project.
If you need to edit content that is scheduled, select Remove Scheduling and Edit, edit
the content and reschedule.
You can continue working with a project after it is published.

Removing content and deleting projects
Removing content from projects
Remove a content item from a project by selecting the item in the project overview or from
the project items navigation pane and then selecting Remove from Project from the
item's context menu. Removing a content item from a project means that it is no longer
associated with the project but it is not deleted from the website.

Deleting projects
Delete a project by selecting the project in the project bar and then select Delete Project
from the context menu. Associated content items are not deleted but are no longer associated with a project. You cannot recover deleted projects. When deleting a project with
items scheduled for publishing, you can keep or remove the scheduling for each item.
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Examples of using the project functionality
Publishing a customer event using projects
This example creates an invitation to a customer event, including a registration form (using
a block), a thank you for the registration-page, and a teaser block for the start page. All content items for the event are scheduled to publish at the same time.
1. Create a new project for the event from the project bar and call it Customer event.
2. Prepare a page with information on the event. The page is automatically added to the
project. You can set the page to Ready to publish or do that at a later stage.

3. Prepare a thank you-page.
4. Create a registration form using the built-in form functionality or the Optimizely Forms
add-on. Set up the form so that a visitor who registers for the event is directed to the
thank you-page.
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5. Create a teaser block to use on the start page for promoting the customer event and
drag it to the start page. The Customer event project now contains all items related to
the event.

6. Preview the pages by clicking the preview button

.

Does the start page contain the teaser?
l
Does it lead to the customer event detail page?
l
Fill in the form and make sure that you are directed to the thank you-page.
7. Go to the overview and select all items by pressing Shift on your keyboard and selecting the top and the bottom items.
l
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8. From the context menu of one the items, choose Ready to publish and all items are
ready to be published.
9. Select Options > Schedule Items for Publish in the overview.
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10. Select 1 August at 11 AM and click Select.
Note: You cannot edit scheduled versions of items that are part
of a project. If you need to publish the start page before the
scheduled version is published, you need to create a new draft
and then publish that. To incorporate the same changes into the
scheduled project version of the start page, you must remove the
scheduling, edit the content and then re-set the scheduling.

Managing multiple content language versions using projects
This example creates a page with a registration form block for an event. The included items
need to be available in English (the original website language), French and German, and
you will manage the translation using a project.
1. Create a project and name it Spring Meeting.
2. Create the page and the related forms in English first. They are automatically associated with the project.
3. Enable and activate the desired languages (here French and German) on your website,
if not already done. (Must be done by an administrator.)
4. Switch to the French language branch and create a French version for the page and
the forms block.
5. Repeat the previous actions for the German version. You now have six content items in
the project, two for each language. You can see all six items in the Project Items navigation pane.
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Note: A language code appears for items in other languages. In
the image above, the English site is selected under Sites; therefore, items in English are not marked with a language code.
6. Translate the content items into French and German respectively. Use compare to display the original English version when translating. Use preview to verify the different
language versions of the content.
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7. Set all content items to Ready to Publish when done, and publish the project or schedule it for later publishing from Options in the project overview.
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Reports
Reports are valuable tools for content editors, website owners, marketers and merchandisers, to monitor various website activities. Optimizely comes with a set of built-in
reports, and you can develop customized reports for your website.

Reports for CMS content
You can use reports for websites to locate broken links and expired pages, or to get an
overview of simple addresses used on the website. Obtain reports from the Reports option
in the Optimizely CMS global menu.

When you generate a report, select the desired report and the starting point in the page
tree from where you want the report to include data, then click Show Report. You can filter data by time and language, and pages included in the report results open in edit view
when you click a page link.
The following sample reports are available for Optimizely CMS:
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Report

Description

Not published
pages

Displays unpublished pages that have a change date within a specified time
span.

Published pages

Displays pages that have a publish date within a specified time span.

Changed pages

Displays pages that have a change date within a specified time span.

Expired pages

Displays pages with stop publish date within a specified time span.

Simple addresses

Displays pages with a simple address.

Link status

Displays links that could not be contacted in the link check scheduled job.

Some reports rely on scheduled jobs running in the background for generating report data;
see Scheduled jobs in the CMS Administration User Guide.

Reports in Commerce
You can use reports in Optimizely Commerce to follow-up on sales performance, or to monitor inventory stock information for products. See Reporting in the Commerce user guide, if
you have a website with Commerce installed.
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Search
The Optimizely platform has sophisticated search functionality that lets you search
through different types of website content. You can search for content pages, blocks, files,
community objects, and products, if Optimizely Commerce is installed. The search results
are based on access rights, so users only see content to which they have access.
To build advanced search features based on visitor behavior, customized filtering and
faceted content navigation, you can use Optimizely Search & Navigation; see the Optimizely Search & NavigationUser Guide. It is included in the Optimizely Cloud services; for onpremises installations it requires a specific installation and license.

Search options
Depending on how your Optimizely installation is set up and from where you are searching,
there are different options:
l

When editing, the global search is available in the upper right part of the top menu.
Depending on the configured search providers, this option can search all types of content
on the website: pages, blocks, files, and catalog content if you have Optimizely Commerce
installed.
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l

When editing, a search option is available at the top of the navigation and assets panes,
and in the link dialog box. This option searches for content in the panes and related dialogs.
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l
l

Searching in the CMS edit view is described in the Finding content topic.
Site visitors can usually search content through a search field and a search page on the
front-end site, as in the Optimizely sample templates.
Note: You can add items directly from the search result list to, for
example, a page or a block through drag and drop.
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Search tips
l

l
l

l

l

Enter a few carefully selected keywords separated by space. If need be, narrow down your
search query by adding keywords. For example: optimizely product project.
If you know a page ID, search for the page by entering the ID in the search field.
When searching for specific phrases, combine keywords using quotation marks. Example:
“optimizely search tips”.
The search function is case-insensitive, so you can use both uppercase and lowercase letters. Example: New York and new york return the same result.
You can use the boolean operators AND and OR.
o

o

AND means I only want documents that contain both/all words. Example: optimizely
AND search returns documents with both words.
OR means I want documents that contain either word. Example: optimizely OR search
returns documents with either optimizely or search.

Sorting search results
The sorting of search results is determined by the search algorithm. Often, filtering is
applied to the results, which can be based on many factors, such as categorization of content.

Configuring search
Optimizely search has configuration options that are managed from the administrative
interface in Optimizely CMS. See the technical documentation on Optimizely World for
information about search functionality, configuration possibilities, and integration interface.
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Optimizely Digital Experience
Platform
The Optimizely Digital Experience Platform unifies digital content, commerce and marketing in one platform, including omnichannel solutions for intelligent campaigns. The
platform uses artificial intelligence and behavioral analytics to deliver personalized experiences everywhere. With our secure, reliable platform you can quickly increase engagement, revenue and productivity, while getting the fastest time to value.

About Optimizely
At Optimizely, we're on a mission to help people unlock their digital potential. We equip teams
with the tools and insights they need to experiment in new and novel ways. Now, companies
can operate with data-driven confidence to create hyper-personalized experiences. Building
sophisticated solutions has never been simpler. Learn how we unleash new limits at optimizely.com.
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